Digital Electronics
for Musicians

Build Intuitive Electronic and
Electroacoustic Music Interfaces

. Alexandros Drymonitis

\ s .
APTess®




Digital Electronics
for Musicians

Alexandros Drymonitis

ApPress’



Digital Electronics for Musicians
Copyright © 2015 by Alexandros Drymonitis

This work is subject to copyright. All rights are reserved by the Publisher, whether the whole or part of the
material is concerned, specifically the rights of translation, reprinting, reuse of illustrations, recitation,
broadcasting, reproduction on microfilms or in any other physical way, and transmission or information
storage and retrieval, electronic adaptation, computer software, or by similar or dissimilar methodology now
known or hereafter developed. Exempted from this legal reservation are brief excerpts in connection with
reviews or scholarly analysis or material supplied specifically for the purpose of being entered and executed
on a computer system, for exclusive use by the purchaser of the work. Duplication of this publication or
parts thereof is permitted only under the provisions of the Copyright Law of the Publisher’s location, in its
current version, and permission for use must always be obtained from Springer. Permissions for use may be
obtained through RightsLink at the Copyright Clearance Center. Violations are liable to prosecution under
the respective Copyright Law.

ISBN-13 (pbk): 978-1-4842-1584-5
ISBN-13 (electronic): 978-1-4842-1583-8

Trademarked names, logos, and images may appear in this book. Rather than use a trademark symbol with
every occurrence of a trademarked name, logo, or image we use the names, logos, and images only in an
editorial fashion and to the benefit of the trademark owner, with no intention of infringement of the trademark.

The use in this publication of trade names, trademarks, service marks, and similar terms, even if they are
not identified as such, is not to be taken as an expression of opinion as to whether or not they are subject to
proprietary rights.

While the advice and information in this book are believed to be true and accurate at the date of publication,
neither the authors nor the editors nor the publisher can accept any legal responsibility for any errors or
omissions that may be made. The publisher makes no warranty, express or implied, with respect to the
material contained herein.

Managing Director: Welmoed Spahr

Lead Editor: Michelle Lowman

Technical Reviewer: Johan Eriksson

Editorial Board: Steve Anglin, Pramila Balan, Louise Corrigan, James T. DeWolf, Jonathan Gennick,
Robert Hutchinson, Celestin Suresh John, Michelle Lowman, James Markham, Susan McDermott,
Matthew Moodie, Jeffrey Pepper, Douglas Pundick, Ben Renow-Clarke, Gwenan Spearing

Coordinating Editor: Mark Powers

Copy Editor: Kimberly Burton

Compositor: SPi Global

Indexer: SPi Global

Artist: SPi Global

Distributed to the book trade worldwide by Springer Science+Business Media New York,

233 Spring Street, 6th Floor, New York, NY 10013. Phone 1-800-SPRINGER, fax (201) 348-4505, e-mail
orders-ny@springer-sbm.com, or visit www.springeronline.com. Apress Media, LLC is a California LLC and
the sole member (owner) is Springer Science + Business Media Finance Inc (SSBM Finance Inc).

SSBM Finance Inc is a Delaware corporation.

For information on translations, please e-mail rights@apress.com, or visit www.apress.com.

Apress and friends of ED books may be purchased in bulk for academic, corporate, or promotional use.
eBook versions and licenses are also available for most titles. For more information, reference our Special
Bulk Sales-eBook Licensing web page at waw.apress.com/bulk-sales.

Any source code or other supplementary materials referenced by the author in this text is available to
readers at www.apress.com/9781484215845. For detailed information about how to locate your book’s source
code, go to www.apress.com/source-code/. Readers can also access source code at SpringerLink in the
Supplementary Material section for each chapter.


mailto:orders-ny@springer-sbm.com
http://www.springeronline.com
mailto:rights@apress.com
http://www.apress.com
http://www.apress.com/bulk-sales
http://www.apress.com/9781484215845
http://www.apress.com/source-code/

Contents at a Glance

About the AUthor ... ———————— XV
About the Technical ReVIEWET ........cussssssssssssssssssssssssssssssssssssssssssssssssssssnsssassnsnsnsns Xvii
Acknowledgments........cccccuuiissssmmnnmmmmmmssssssssssssmnmmessssssssssssnssensssssssssnnnnnnnsnssssssnnnnnnns Xix
INtroducCtion .....ccuiieermssannmsssnnmsssnnmsssnnsssannsssannnsssnnsssannnsssnnssssnnssssnnssssnnnsssnnnsssnnnnssnnnss Xxi
Chapter 1: Introduction to Pure Data...........ccccmmmmmmnnninnnnnssssssmnnnnsnssssssssssssessssnes 1
Chapter 2: Introduction to Arduino.........ccccrnissenmmmnsssssnnmssssssssmssssssssesssssnssssssssnnns 51
Chapter 3: Embedded Computers and Going Wireless ........cccussseensssssssssssssssannnns 97
Chapter 4: Getting Started with Musical Applications .........cccuseemmnisssnnnmnsssnnnns 141
Chapter 5: A Simple Synthesizer Using a MIDI Keyboard and Arduino ............. 177
Chapter 6: An Interactive BOW........ccccseemmmmnsssemmmnnssssnmmssssssnmsssssssssssssssnsssssssnns 233
Chapter 7: An Interactive Drum Setl........ccccvnrmmmnnnsennmmmmsssnnmsssssmssssssn—ms 267
Chapter 8: A DIY Theremin .....ccuceseesssmmmmmmmmssssssssssmsssssssssssssssssssssssssssnssssssssssssnns 317
Chapter 9: Making @ LOOPE .......ccccummrmsssnnnmmssssnsnssssssssnssssssssnssssssnsssssssnnnnsssssnnnnss 363
Chapter 10: A Patch-Bay Matrix SynthesSizer ..........cccivnnsmmnnnnssssnnnnnssssnssssssnnns 417
INdeX.ciiiiiirii e ——————————————=—— 481

iii



Contents

About the AULNOF .....cceiiiiieemmmmisssnnmssssn s annn e s annn e e nnnn s XV
About the Technical REVIEWET ......cuussesssssanssssanssssansssssnsssssnsssssnsssssnsssssnsssssnnssssnnssss xvii
AcknowIedgmEeNtS.......cceerrmssssssssssnmmmmsssssssssssssssssssssssssssssnnnsssssssssssssnnnnnnssssssssssnnnnnns Xix
INtroducCtion ......ccccmmissnnnnmmssssnnnmsssssnnnnsssssnnnnsssssnnnnnsssnnnnnnssssnnnnnssssnnnnnsssnnnnnnsssnnnnnnnssn XXi
Chapter 1: Introduction to Pure Data..........ccccccmmninemmmmnnnssnmmmnssssnmnssssnmmsssssns 1
Pd BasiCS: HOW [t WOIKS.......cccurerrerrensessessensessesssssesssssessesssssssssssssssssssssssssssssssssssssssssssssnnes 2
OUP FirSt PAtCR.......eceeeeeee e r e 3
The Control DOMAIN ... e e s e e e e b e e p e e 6

L o T [0 (T (o T O RORSR 7

5 T O 8

0] 1) 1T 1 OO RSRRSR 10
(6T 1 5 (-] SRS 10
GUIS .ottt R e A AR e R e e R e Re e e Re e aean 11
Pd Patches Behave LiKe TEXt FileS........ccoouveririineicsncsisse e sn e sssessssesnsssnnens 12
Making OSCillators in Pd..........cccvorircenirsrser e 13
Making a Triangle Wave OSCIllator ..o s 14
Making @ SaWto0oth OSCIllATON ..o s 15
Making @ Square Wave OSCIllator.............ococoeerrencnineecsess e 16
USING TADIES IN P ... sa s saesaesa s sn e a e sa e sa e sn s sn s sn e n s 17
Subpatches and ADSEraClions..........cccccvveercrernc e 20
Control Domain vs. Signal DOMAIN..........ccceeerereresere e sss e s snssnssssseas 24
AUiO INPULIN P ...t se e se e s s s s sn e s sn e saesn e sanennesanennenns 26



vi

CONTENTS

Basic Electronic Music TEChNIQUES ........ccccecrverrerrerirer s 27
AdAItIVE SYNTNESIS ......ceeeeccererceirer e nnnnns 27
RiNG MOUUIALION........c.ceeeeceie e e e enp s 28
AMPIItUdE MOAUIBHION........ceeeereeeee et nennns 29
Frequency MOTUIALION ..o p s 30
ENVEIOPES ..ot R e e e e R e 31
DElay LiNES iN P ...t se s ne s 34
REVEID ...ttt R e AR e R e e e R e 38
T OO STSTP 39

Making Wireless CONNECLIONS .........ccvcerverrersersersessessesses s s s s sessessas e e sessessassassssssssnes 42
AUdio and MIDI SETHNGS ....veceeeererererrererrerserereseseresersssessssessesessessssessssessssessssessssssssssssessssessssersesssssnssaes 46

Additional TROUGRLS........coeeeeecccecere e sresr e sresr e resn e sn e nennennnnns 49

0] o (1 o o PSPPSR 50

Chapter 2: Introduction to Arduing..........cccccumssemmmssensmssnsmssssmsssssssssssssnsssssnssnsns 51

Arduino JUMP STAr ... a e 51

g 30 I 52

The BIINK SKEICH .......cceiicircri s 33

Digital INPUL.......coeeeeeeerrer e a e s n s 39
Defining Variables in ArQUINO.........cc.ouececrerrecrieecs s 60
Further Explanation 0f the COTE ... 60
Classes in Arduino and the Serial ComMUNICALION...........cccocrerenenencninenenenere s 61
FURTNEr EXPIANALION ..ot e e e p s 61
Building Circuits 0n @ BreadbOard............coeeeeererensenenesnesesesssesesesssssssesssssssessssssssssssssssssssssssssssssssssaes 61

Pull-up vs. Pull-dOWN RESISIOrS .....ccccveeverierririeereree e rssessessssssesssssesssesssssssssssssssssesaesns 64

Both Digital Input and QUEPUL ..o 66

ANQIOG INPUL ... sn e sn e nnennn e 69

Analog Input and QUPUL........c.ooerececer e sn e nnenens 7

Reading More Than One Pin, Arrays, and the for Loop ........ccccvererrssrcessssessessessessenneas 74
EXPIAining the fOr LOOP.......ccoiiirere sttt n e s st sn s s s a e se s snnnens 74
USING Arrays in AFQUINO .......coeeciieiencriressese e se s e s s s s b st se s s e s a e e ne e nenesnnsnnnnns 75



CONTENTS

Analog and Digital INPUL ..o 77
Communicating With Pd ... 81
Sending Data from Pd t0 Arduinog .........cceeeeeesrsssesss s sns s 91
00] o [T 0 o PSPPSR RRRN 95
Chapter 3: Embedded Computers and Going Wireless .......ccccsrrrmsssssssnsssnssssssssnns 97
Before YOU BEgiN .......cccevierriiicnincse st s snnne s 97
PartS LISt .....ccoeiiisiriit i 98
Why Use Embedded COMPULEIS? .......cccvcreeriercerrer s se e e s e s s s snnnns 98
Which Embedded COMPUIEI? ..ottt s e e e e sa s s s e e e sa e sa e e s sassa e sa e sn e saesannae s 99
Getting Started With the Pi..........ccoeoicerniresrcrererr s 100
GEtting YOUr COMPUEBI'S IP.....o.eeeee ettt 101
Logging in the Pi from 0S X @nd LINUX ........ceceeeerrrrencrirneesesesesesesesssssesessssssesessssssssessssssssesssssssssnns 102
Logging in from WINAOWS ........oueeeeeerreecrissescsessse e sesss s ssssssssesssssssssssssssssssssssssssasnns 102
CONFIGUIE e Pl 106
Navigating Through the LinuX SYSTEM .........ccccvvrrerrrnnsenserserses s e e e e e sessesenns 107
Editing TEXt FIlES iN LINUX ...vcoveceeeereerererereresersssersesessssessesessessssessssessssesssssssessssessssesssssssssassesassesssnenes 109
INSEANlING SOMWAIE ... sr e r e sn e sn e snenrenen 110
TS e LT T N oo OO 110
LAUNCRING PU........eeee et p e e e e p e p e s 111
Setting up External LIDraries in Pd ... sse e ssssessssessessssens 112
INSTAIING AFQUINO....c.veecctccee e e e e p e e e e e e p e e 114
Let’s Talk ADOUL VEISIONS .......cocvrereririsisisisisisisisisisisis s sssenes 115
Exchanging Files Between Your Computer and the Pi...........cccoovevennicnnsenenessesennennes 116
Transfer Files from 0S X and Linux to the Pi, and Vice Versa..........ccccocvvvrvrnvnncnenencevensenessessenennns 116
Transfer Files from Windows to the Pi and Vice Versa............ccoovrnnnnnnnnssessesesesesesesesesesesenens 117
Changing the IP 0f the Pi......ccceeeececercerrrr s sae e e 119
Setting @ STatic IP 0N LINUX.......ccoverererecreesereseresesessssessesessesessesessessssessssesssssssessssessssesssssssssassssassens 120
Setting @ STAtiC IP 0N 0S X.....coevererrerecree s st res s s rsesesae e s e sasaesas e saesessesesaesassesassesaesesassesseanaens 121
Setting @ Static IP 0N WINUOWS.......ccccereererererererereressssereesessesessessssessssessssessesssssssssesssessssssssssssssassens 122
Log in t0 the Pi WithoUt @ ROULET ..........covveverereereree st rese s reesessesessesessesas e sassesassessssessesassesassenes 123

vii



CONTENTS

Shutting DOWN the Pi........cccoeeeiiierincrerse s sesssssssnsnens 124
GOING WIFBIESS....veruereereereereersersessersessessessesaessesaessssaesassassassassassassaesassaesassassaesasssssassasnnnns 126
BIUEOOth VS. XBEE.....cciiiiiiiiiiii s 126
Using a Bluetooth Module With ArdUINO ..........coceeereerrererererereercrre e rerese s e ssesessesesassessesassessssenes 128
Using the XBee With ArdUing ... 131
0] 3T 1o 138
Chapter 4: Getting Started with Musical Applications .........ccusemrrnissennnnnssannns 141
0 I 141
Phase Modulation INterface...........ccoevreennrennennsesr e 141
How Phase Modulation WOTKS ..o 142
MaKing the Pd PAIC...........ccoeireeese et e 143
Arduino Code for Phase Modulation PatCh ... 146
Circuit for Arduing COOE.........c.coererereerereerereeese e 149
A Simple Drum Maching INtErface........ccccvvereerieeririeerser e ssee e ssse e ssse e ssaessessassns 150
50T o [T T T TN 2 I o2 1 (1 151
Arduino Code for Drum Maching PatCh ............cvvinnnnssss s 162
Drum Machine and Phase Modulation Combination ............ccevnmnsennnnsnnssennnns 166
AFAUIND COUE ... 166
Arduing GIFCUIL......cocviriririrircririsisisis s 169
Pd Patch for Drum Machine-Phase Modulation Interface..........c.coovvnninnnninnnnnnnsssses 170
00] T [T [0 o TSR 176
Chapter 5: A Simple Synthesizer Using a MIDI Keyboard and Arduino ............. 177
o L Gl I PSSR 178
WHAL IS MIDI? ...t sn s sn s srenr s ne s nn s nner s 178
Pd and MIDI ..ot sn s n s nr s n s sn e nr s nn s n e nn s nn s nnennnn 179
HOW [NOTEINT WOTKS ...ttt s e e s s p e e 180
Using a Different Tuning and an Amplitude Envelope with [notein].........cccovvinivnicncccnccnscccnnenn 181
Polyphony With MIDEIN Pd........corencr s sn e ns s e sn e sa s sae s 183

viii



CONTENTS

MIDI Control MeSSAQES iN PU........ccceeerererereriere s seseesesesesessssessesessesesssssssessssessssessssssssssssesassesssnenes 186
Pitch Bend MeSSages iN P ..o sse e s sss s s ssesssssssssssssssssssasssssssssssssses 188
Program Change MIDI MeSSaQges iN Pd...........couvnmninnnssssssssssesssssssssssssssssssesssssssens 190
Arduing Code........coiruienmriiiiriei s 191
EXPIaining the COe.........cvnninniiiiiis s 194
o0 I o 1 (] 1 OSSPSR 196
The arduino_Stuff SUDPALCH .......eeeeeee e 197
The create_envelope and generic_data SUDPAICNES .......cccovvererernerenirne e 198
The [poly_Synth~] ADSTFACLION .......ceeeererrreesirerse e sa s e n e nnnnns 200
The [pd $0-voice_creation_loop] SUDPALCH..........ccccururerererereresectrerere s assseseessnees 201
How Dollar Signs WOIK iN P ........cccvieenernnesesssrsssessssssssesesssssesessssssssessssssssssssssssssssssssssssssssssssasnns 203
The [Synth_v0oiCe~] ADSTIACTHION........cccceeerrrecrerr s p e nn s 203
The filter~ SUDPALCH.........cccereriecrrr e e esp e nnnr s 210
Done with Patching, TIMe 10 TES.......cvccceincrerrrresesrrre e 211
Arduino Receiving MIDI Messages from the MIDI Keyboard ..........c.cccccvvvrcrceererienne, 213
Arduino Circuit AdGItIONS ... 213
Arduing Code AdGItiONS ... —————— 215
Pd Patch Receiving MIDI Data from ArdUiNO.........ccoveverinennrn e ssssessss s ssssesssssssssssss s 217
Running the Pd patch on Raspbherry Pi.........ccocvcrcrcrcs s 219
Launching Pd on Boot with the Raspbian Jessie IMage...........ccccerrriencnernencsensese e 220
Launching Pd on Boot with the Raspbian Wheezy Image or with Another Embedded Computer
RUNNING DEDIAN JESSIE ...t e s e 221
Shutting Down the Pi (or Any Embedded Computer)
While RUNNING HEAAIESS ......ccoveeeeerereeceseseccresis s 223
A Small Caveat for the Raspbian and Debian Wheezy Images ..........ccccorreverrnesesenenesescseseeeseneneas 224
Using an External Sound Card With the Pi............oeeeeee e 225
Editing the Pd Patch When Pd is RUNning on BOOt ............ccovuiiiennencecreneesesesee e 227
Enclosing the Pi in the Keyboard............ccouceeeieenicicsnscsssesessse s ssssennas 228
Choosing the Perforated BO@rd............cccceererreienerrsrsssesessssesesessssssesessssssssessssssssssssssssssssssssssssssssssssssnns 228

ix



CONTENTS

Reducing the Wires of Your Circuit Board............cccuovenriernnmsesnsesessssesessessesessesesesnes 229
Choosing the Right Power Supply and Getting Access to the Power Pins..........cccccvevrevrccnenccrenenn 230
AcCESSING The MIDI PINS ......coveuieeeeirirecsereseesesesss s se s se s sessssssssesssssssssssssssssssns 230
Bringing the Power Input and Audio Output out of the ENCIOSUIE .........cccovrureecnerencrerereneeeseeeeeens 232

CONCIUSION.....ceieicccii e 232

Chapter 6: An Interactive BOW........ccccuseemmmnisssesnmnnsssssnmmssssssnmsssssssssssssssssssssssnnns 233

PartS LISt ..o 233

Writing Custom FUNCLIONS ........ccocevcrcerirer s 234
A Function of the Data TYPe VOId ..........cceeeierninnrne e sss s sessesss e ssssessesesnes 236
Actual Code for the ProjECL..........ccoe i r e a s s p e 237
The Test Circuit of the ACCEIErOMEter...........cocvvrnnnnn s —————— 240
The TeSt Pd PatCh ... sssaes 242

Building the Pd PatCh ..o 243
How to Use the Graph-0n-Parent FEALUIE ............ceceeceerereccrirreeserese e 243
Setting the Properties of the GOP GUIS...........coeeererereresirneescresee e sessssens 245
What We Have Achieved So Far in this Project’s Pd Patch ... 245
Using the Canvas to Create Visual FEedbhack...........ccocvvreeererereicnerinnesesirse s 246
Building the Audio Processing Part of the PatCh ... 248
The FiniShed PatCh ... 255

Additions to the Arduing SKetCh..........ccccevvmmnns s 258

Finalizing the CiFCUIL...........coceeeeeeece s sr e sr e snesn e sn e snesn e sn s snesnennennns 260
Using Bluetooth and a Voltage Divider Instead of the XBee.........cccccevvrernicrnvcnnsnccnssenesesessnens 264

00] T [T [0 o TSR 266

Chapter 7: An Interactive Drum Set.........coorrmmmmmiinnnnnssssnn . 267

o L Gl I PSSR 267

Other ThiNgS WE'll NEEd ........coeeuereererereereesee e see e ssssaessssasssssssssssassasssssassassasssssasssssnnns 268

First Approach to Detecting Drum HitS........ccoccvcrcrcrsncs s snnens 268
First Version of the CirCUIt .........c.covrnnininnnninissss s 269

Read the Drum HitS iN Pd ..o ssssssssssssss s ssssssssssssssssssssnssssssnssanssnens 270



CONTENTS

Getting the Maximum Value in ArdUINOD.........cecceerererererererereresserse s sesseresesassessesessssessssassesassessssenes 271
Getting the Maximum ValUE iN Pd..........covevrierererrrirsrere s ssssersssessesessesessesssessssesssssssssassesassessssenes 277
Having Some Fun Before We Finalize...........cccvcveervercercscs s ses e 280
Working Further with the Circuit and Arduing COUE ..........correrererreicrireeereree e 282
Adding Switches and LEDs to the Circuit and COde ...........coereecrerrercrernecrerese e 282
Building the Final Pd PatCh ...........ccoeoieeicresrcsc e 289
Building the Audio File ADSIraCtion...........covvceeerrinesenrrcsese e enes 289
Building the Abstraction to Receive Input from the Arduino............cocoeoeeeeenenerencnenencseeereeeereeeeee 301
Sending the Threshold and Debounce Values to the Arduino ...........ccoecrevrerrcerncersrere e sererenaens 302
THE MAIN PALCN.......coceeec e 302
Finalizing the Arduing COE..........ceverrerrerrerserserserses s s sesses e se s e sns e s snssnssassnssassasnnnns 308
Making the CirCuit ENCIOSUIE ........c.coeieeecececeectecsecse e sse s s e s s s sns s snenns 311
CONCIUSION.....cuieiccccirr e 315
Chapter 8: A DIY Theremin ......ccccceeemmmmmmsssssssssssssnsssssssssssssssssssssssssssssnsnnnssssssssns 317
T I 317
Using a Proximity Sensor with the Arduing .........cccoceercveenicrec s 318
Refreshing Our Memory on SEralWILE .......ccccveeererrerererereree e sse s e erae e sse e saesessesassesassenes 319
ProXimity SENSOr CIrCUIL......ccecereerererererereresseree e s ssssesseresessssessesessesessesassesassessesessssssasassesassesssnenes 319
Pd Patch That Reads the Proximity SEnsSor Data.........ccccvcevvvererrereneresereresseres s sessesessessesenes 320
Smoothing out the SENSOr VAIUES...........cccveeererererircrs e sese e se s saesessesessesassesassesassessssasssnasaens 321
Using Two Proximity Sensors and Four Potentiometers..........ccccoeeeeecececscessessennnnns 326
The Arduineg COGE ... 327
THE CIFCUIL ... e 329
The Pd PAICh.......ce 330
Building the Oscillators for the THEremin...........ccoovceeerceresnsessse s 331
Creating Band-Limited WaVefOrms.........c.couvvererinesesesnsesesssssesesssssssesssssssssssssssssssssssssssssssssssssnes 331
Reading the Stored Band-Limited Waveforms...........cocvverernnnnenesssssssesssssssessssssssssessssssssesssssssssnens 335

xi



CONTENTS

Finalizing the INterface...........coccoverinirenscre e 339
Adding Push Buttons to the Arduino Code to Control the Waveforms of the Oscillators..................... 339
MaKINg the CIrCUIL .......coveveeceereccir e e 343
PULEING [t Al TOGETNE ...t 345

Enclosing the Project with an Embedded Computer.........ccccvvvvrvrvrvrsnsenses s 354
Adding a Push Button for Switching off the Embedded Computer.........ccocvcvevverrerercerenreresrereenenens 356
Reading the Extra Push BUHtON iN Pd..........ccoeerevrer et sesse e seses e ssesesaesessesessesassesassenes 358
Writing the Script to Shut the Embedded Computer DOWN ........ccccveveriererreressereerereesessesesessssessesenas 360
Loading the Pd PatCh 0N BOOL...........cccoerirerirerercre e sse e ssesas e ssesesassessssesaesassesssnenes 360

0] 3T 1o 362

Chapter 9: MaKing @ LOOPEY .....ccccccerrrssssnmnmsssssssnssssssnssssssssssnssssssnnsssssssnnssssssnnnnss 363

a0 I 363

What IS @ LOOPEI?.......ceeeerererer sttt sn s s n e e 364

Recording Our First SOUNAS iN Pd .........ccocvvrininrererserser s ses e e sas e sesnens 364
Playing Back the ReCOrded SOUNG...........cccevurrereerereerererrerererersssersesessesesssssssessssessssesssssssssessesassesseneres 365
Changing the Direction of the PlaybhackK...........ccceererrrrrcerrie s se e sessesaeenes 370

Making Recordings of Arbitrary Lengths.........cccocverircrcscssssesses e e 372
Retrieving the Length of the ReCOrding.........ccovcrvcircncrnsc e 374

L0412 (o 111 0] o o TSR 376
Getting Rid OF ClIPPING ......ccoceereeecrerereseerirrs e s e e sn e 376
Getting the Start Position of the OVerdubbing ..o 377
Knowing When to Stop OVerdubbing .........ccccecernencninneesesesee s sesessssssssesessssssesssssssssnns 378

Synchronizing End of Recording with Beginning of Playback...........ccccecvvvvrvrcercnnnen. 380

Start Building the Interface ... 381
Writing the Arduing COTE.........corcrerererr e s r e s s r s e p e e nenrenas 381
Building the Circuit on @ Breadboard...........cccovvreriecncrnersrcrerese e sss e sse s 392

Working Further on the Pd PatCh ... 393
The Recording MOTUIE..........cccov e e 393
THE PRASE MOTUIE ........ceeeeieecee e 394
The Playback MOTUIE ........cccourureeirirecrirereeeress e nn s 396

xii



CONTENTS

The OVerdub MOQUIE.........cciei s 396
The Overdub PoSition MOUIE............cocociiriniiiis s s 397
The Arduing MOTUIE..........ovrrnisiiii 399
The Table COPYING MOUUIE .......c.ecereerererererereresserse e sse e ssessssessesessssassesassesassesasssssessssesassesassesssnsnaes 400
PULting I AL TOGEINEN ... e r e a e r e e s 403
Making Some Final IMprovements...........cccvercrcrsssesss s snssneens 406
Modifying the Arduing COUE.........cccoreiieererrecri e 406
Modifying the Pd PAICH.........cooeceee e 409
Enclosing the Circuit in @ BOX........ccooveereeenseresssessssesessssessssessssssessssssssssssesssssssesssssnnes 414
CONCIUSION.....cceecc it 416
Chapter 10: A Patch-Bay Matrix Synthesizer .........cccounnmmmmmmnnnnnmnnnnsssssnnnnnemmn. 417
PartS LISt .....cceiicsiriniinss s 417
What We Want to Achieve in this Chapter..........ccccvrrvrirsssscs e 418
Extending the Arduino Analog Pins.........cccvvrvrnniennersesses s sesses e e e ssssesenns 419
HOW @ MUIIPIEXEE WOTKS ......coverieccerrsreceresssesesssss s sesssssese s sssssessssssssesssssssssssssssssssssssssssnssssssssasnes 421
Writing Code to Control @ MURIPIEXE .........cceeeeereeecrrrrse e se s se s snssns 422
Wiring 16 Potentiometers 10 the MUIIPIEXET .........ccceeerireeserrrrescrerse s sessns 426
Reading the 16 Potentiometers in Pd............cccceirencnnnccsesrsesess s sssssssenns 427
Extending the Arduino Digital Pins ... 428
Using the INPut SNift REJISTE.......ccvveerererererrerre st res e sre e sse e sse e s ae e sas e sae e saesassesasnenes 428
Using the Output Shift REGISIET ......ccceverrerrer e ra e sa e e e 434
Combining the Input and Output Shift REGISIErS ......ccccevrcerrrerrrerr e 439
Making a Patch-Bay MatriX...........cccverircersnsnsesses s se s e s snnnns 441
Implementing a Patch-Bay Matrix with the Arduing............ccoreeeeerneessneerr s 441
Making the Pd Patch That Reads the COnnections.............ccooreoernriccncnnneseses e 445
Making the Patch-Bay MatriX CirCUIL...........ceoeeeririeeeee e 447
Start Building the Audio Part of the Pd Patch..........ccccooeerireercceecreeescceeesceeeens 449
A Signal MaLFiX iN P ..o s s se s sesssss s e sssssssssssnsans 449
Building the Modules for the SYNthESIZEr ..........ccoveeerrncrererreesere e 451

xiii



CONTENTS

The FINAI PALCN.........coeeerceter e 466
The arduino_stuff SUDPALCN ... —————— 467
The Final Arduing COdE ..o 471
Using Binary NUMbers for MasKinNg.........ccccverererereererererseressessssessesessesessessssesssessesessessssssassesassessenenes 475
The check_connections FUNCHON ... 475
The Main [00P FUNCHON ......ccceeverere s rerereseseseree e sessesasserassessesessssessesassessssesassessssassesassesasnesasenaes 475
Controlling the LEDs with the Switches of the Shift RegiSters.........ccevvrerrrerrrererererrerereresereesenns 476
The Final CirCUIt ..o 476
MaKing an ENCIOSUNE.........c.coerereeceerie e s s sse s saesaesne s s e sassaesassaesaesassnssnennennns 477
Shutting down the Embedded COMPULET..........cooerrriirerrccr e se e 478
CONCIUSION.....ceieicccii e 479
INA@X . iiiiiissnnnnnnnnnnnnsssssssnnnnnnnnnnesssssssnnnnnnnnsssssssssssnnnnnnnnssssssssnnnnnnnnnnssssssssnnnnnnnnnnsssssnnn 481

xiv



About the Author

Alexandros Drymonitis is a musician from Athens, Greece. He studied

at the Conservatory of Amsterdam, where he got his first exposure to
music technology. Ever since, he has been creating electronic music using
open source software and hardware such as Pure Data and Arduino, as
well as giving workshops on electronic music programming and digital
synthesizer building. He is also very keen on community building, and is a
founding member of the Patching Circle Athens group, a group of users of
visual programming languages.

XV



About the Technical Reviewer

Johan Eriksson is a composer and electronic musician from the north of
Sweden. He has a first class degree in composition from the Birmingham
Conservatoire in the UK and has had his work commissioned and
performed across the UK and Sweden. Johan has been releasing records as
“Monolog X” frequently since 2007. Modular synthesis is very dear to him,
especially the Pure Data language. In early 2015, he released XODULAR,
which is a virtual modular synthesizer environment in Pure Data that was
given a very warm welcome by the Pure Data community and introduced
new people to the language.

xvii



Acknowledgments

The communities of Pure Data and Arduino have been of great assistance prior and during the writing of this
book. Also, I would like to thank Michelle Lowman from Apress for asking me to write this book, as well as
Miller Puckette for creating Pure Data.

It wouldn’t have been possible to reach a point where I would be able to write a book on these subjects
without the long support of my parents, and I wouldn’t have been able to write this book without the support
and patience of my lovely wife.

Xix




Introduction

This book aims at giving insight on a few of the most widely used tools in the fields of creative coding and
DIY digital electronic musical interfaces. It is a result of personal exploration in these fields and an attempt
to gather information about the combination of the very popular prototyping platform, the Arduino, with the
also very popular visual programming language for multimedia, Pure Data (a.k.a. Pd).

The main focus of the book is interactivity with the physical world, and how to make this musical. It is
split among several projects where each project brings a fresh idea on how to combine musical instruments
with computers, whereas the use of programming builds up gradually. Also, this book uses only open source
software and hardware, because of the great advantages one can have from an open source community, but
also in order to bring the cost of every project to its minimum.

At the time of writing (December 2015) Pd is at a turning point. Being split in two major version up to
now, Pd-vanilla and Pd-extended, the latter version is used throughout the book, since it includes various
external packages, some of which are constantly used in this book. Pd-extended is not maintained any
longer, which leaves Pd-vanilla as the only actively maintained major Pd flavor. This version (which is the
original version maintained by the maker of Pd itself, Miller Puckette) consists of the very core of Pd, lacking
the external packages Pd-extended has. A new plug-in has been introduced though in vanilla which will be
part of the next release, Pd-0.47, to be released during December (but maybe a bit later). This is the deken
plug-in which simplifies the addition of certain external packages to a great extent.

I strongly suggest the reader uses Pd-vanilla once the 0.47 version is published and to install a few
external packages using this plug-in. You can download it from Miller Puckette’s personal website. If you do
so, you'll need to go to the Help menu and choose Find externals. In the window that will open, search for
the following packages: comport, zexy, ggee and iemmatrix. If you do use Pd-vanilla, the following changes
should be applied to all projects of this book. All Pd objects (actually abstractions, but what this is has not
been explained yet) that end with the word “extended” should be replaced by the same object without this
word. For example, “serial_print_extended” should be replaced by “serial_print” All “arraysize” objects
should be replaced by “array size” (there’s a white space between the two words). The “import” object is
not used at all. In chapter three you'll read how you can configure Pd to find these external packages under
Linux, but the process is very similar for the other operating systems. All this will make sense as you read
through the book.

Another issue at the time of writing is that the comport object used in Pd to communicate with the
Arduino seems to malfunction in Windows 10. Hopefully this bug will be fixed shortly. If not, I suggest you
sign up for Pd’s mailing list or forum (their websites are mentioned in chapter 1) and search their archives
for solutions, or even ask people there. Audio issues have also been reported under OS X El Capitain, but
that applies to other audio software too. In general, a brand new version of an operating system is very likely
to have various issues, so be aware if your preference is to upgrade as soon as an OS update is released.

If you want to contact me for any reason regarding this book, drop me a line at
alexdrymonitis@gmail.com.

Now you can start your journey in the world of creative coding and DIY electronics.
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CHAPTER 1

Introduction to Pure Data

Pure Data, a.k.a. Pd, is a visual programming language and environment for audio and visuals. It is open
source and it was made by Miller Puckette during the 1990s. Visual programming means that instead of
writing code (a series of keywords and symbols that have a specific meaning in a programming language),
you use a graphical interface to create programs, where in most cases, a “box” represents a certain function,
and you connect these “boxes” with lines, which represent patch cords on analog audio devices. This kind of
programming is also called data flow programming because of the way the parts of a program are connected,
which indicates how its data flows from one part of the program to another.

Visual programming can have various advantages compared to textual programming. One advantage
is that a visual programming language can be very flexible and quick for prototyping, where in many
textual programming cases, you need to write a good amount of lines of code before you can achieve even
something simple. Another advantage is that you can say that visual programming is more intuitive than
textual programming. When non-programmers confront visual code, it’s very likely that they will get a
better idea as to what this code does than when confronting textual code. On the other hand, there are also
disadvantages and limitations imposed by visual programming. These are technical and concern things like
DSP chains, recursion, and others, but we won’t bother with these issues in this book, as we’ll never reach
these limits. Nevertheless, Pd is a very powerful and flexible programming language used by professionals
and hobbyists alike around the world.

Throughout this book, we’ll use Pd for all of our audio and sequencing programming, always in
combination with the Arduino. The Arduino is a prototyping platform used for physical computing
(among other things), which enables us to connect the physical world with the world of computers. A
thorough introduction to Arduino is given in Chapter 2. This chapter is an introduction to Pd, where we’ll
go through its basics, its philosophy, as well as some general electronic music techniques. If you are already
using Pd and know its basics, you can skip this chapter and go straight to the next one. Still, if you're using
Pd but have a fuzzy understanding on some of its concepts, you might want to read this chapter. Mind that
the introduction to Pd made in this chapter is centralized around the chapters that follow, and even though
some generic concepts will be covered, it is focused on the techniques that will be used in this book’s
projects.

In order to follow this chapter and the rest of this book, you'll need to install Pd on your computer.
Luckily, Pd runs on all three major operating systems: OS X, Linux, and Windows. You can download it for
free from its web site at https://puredata. info/. You will find two version of Pd: vanilla and extended.
Pd-vanilla (simply Pure Data) is the “vanilla” version of Pd, as its nickname states. It’s the version made and
maintained by Miller Puckette, and it consists of the core of Pd. Most of the things we’ll be doing in this book
can be made with vanilla, but Pd-extended adds some missing features to Pd that we will sometimes use.
For example, the communication between Pd and Arduino is achieved with Pd-extended and not vanilla.
Of course, you can add these features to vanilla, but it’s beyond the scope of this book to explain how to do
this, so we’ll be using Pd-extended in all of our projects. Find the version for your OS and install it on your
computer before you go on reading.


http://dx.doi.org/10.1007/978-1-4842-1583-8_2
https://puredata.info/
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By the end of this chapter, you'll be able to
¢ understand how a Pd program works
e create small and simple programs in Pd
e find help in the Pd environment
e  create oscillators in Pd
e make use of existing abstractions in Pd and create your own

e realize standard electronic music techniques in Pd

Pd Basics: How It Works

Pd consists of several elements that work together to create programs. The most basic elements are the
object and the message. An object is a function that receives input and gives output. Figure 1-1 shows
the osc~ Pd object.

LEn ] L]
0SC~ 440

—

Figure 1-1. A Pd object

This specific object is a sine wave oscillator with a 440-hertz (Hz) frequency. There’s no need to
understand what this object does; we’ll go through that in a bit. There are a few things we need to note.
First of all, there is specific text inside the object box, in this case “osc~ 440", “osc” stands for oscillator, and
the ~ (called the tilde) means that this object is a signal object. In Pd, there are two types of objects: signal
and control. A signal object is a function that deals with signals (a digital form of an electric signal). A signal
object will run its function for as long as the audio is on (the audio is also called the DSP, which stands for
digital signal processing, or the DAC, digital-to-analog converter). A control object is independent of audio
and runs its function only when it is told to. We'll get a better picture of the difference between the two as
we go. The last part of the text, “440’, is called an argument. This is the data that a function receives, and
we provide it as an argument when we want to initialize an object with it. It is not necessary to provide an
argument; when there’s no argument in an object, the object is initialized with the value(s) of zero (0).

The second main element in Pd is the message, which is shown in Figure 1-2.

én.essage

Figure 1-2. A Pd message

It is a little bit different from the object, because on its right side, it is indented, and it looks a bit like a
flag. The message delivers data. There’s no function here, only the data we write in the message (sometimes
referred to as a message box). One thing the object and the message have in common is the inlets and the
outlets. These are the little rectangles on the top and the bottom, respectively, of the object and the message.
All messages have the same form, no matter what we type in them. They all have one inlet to receive data
and one outlet to provide the data typed in them. The objects differ, in the sense that each object has as
many inlets as it needs to receive data for its function, and as many outlets as it needs to give the output(s)
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of the function. With the osc~ object, we can see that it has two inlets and one outlet. The left inlet and the
outlet are different than the right inlet. Their rectangle is filled, whereas the right inlet has its rectangle blank,
like the message does. The filled inlets/outlets are signal inlets/outlets and the blank ones are control inlets/
outlets. Their differences are the same as the signal and control objects. Note that a signal object can have
control inlets/outlets, but a control object cannot have signal inlets/outlets.

Objects and messages in Pd are connected with lines, which we also simply call connections. A message
connected to the osc~ object is shown in Figure 1-3.

440
= e

280”

Figure 1-3. A message connected to an object

A connection comes out the outlet of the message and goes to the inlet of the object. This way we
connect parts of our programs in Pd.

Our First Patch

Now let’s try to make the little program (programs in Pd are called patches, which is what I will call them
from now on). Launch Pd like you launch any other application. When you launch it, you get a window that
has some comments in it. Don’t bother with it; it is just some information for some features it includes. This
is the Pd window, also called the Pd console, and you can see it in Figure 1-6. It is very important to always
have this window open and visible, because we get important information there, like various messages
printed from objects, error messages, and so forth.

Go to File » New to create a new window. You will get another window that is totally empty
(don’t make it full-screen because you won'’t be able to see the Pd console any more). Note that the mouse
cursor is a little hand instead of an arrow. This means that you are in Edit Mode, so you can edit your patch.
In this window, we will put our objects and messages. In this window’s menu, go to Put » Object (in OS
X there’s a “global” menu for the application; it’s not on every window). This will create a small dotted
rectangle that follows the mouse. If you click once, it will stop following the mouse. Inside the rectangle,
there’s a blinking cursor. This means that you can type in there. For this patch, you will type osc~.

After you type this, click anywhere in the window, outside the object, and you’ll see your first Pd object,
which should look like the one shown in Figure 1-1. (Note the shortcut for creating objects; it’s Ctrl+1 for
Linux and Windows, and Cmd+1 for OS X. We'll be using the shortcut for creating objects for now on).

Now go to Put » Message (the second choice in the menu, with the Ctrl/Cmd+2 shortcut). This will create
amessage. Place it somewhere in the patch, preferably above the object. Once you've already placed a
message or an object in a patch, to move it, you need to select it by dragging. You can tell that is has been
selected because its frame and text is blue, as shown in Figure 1-4.

messagei

Figure 1-4. A selected message
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If you click straight into the message or object, it will become editable, and it will be blue like in
Figure 1-4, but there will also be a blue rectangle inside it, like in Figure 1-5. When an object or message
looks like the one in Figure 1-5, you cannot move it around but only edit it.

Figure 1-5. An editable message

18 O O Pd-extended

ouT
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Figure 1-6. The Pd console

Type 440 and click outside it. To connect the message to the object, hover the mouse above the outlet
of the message (on its lower side). The cursor should change from a hand to a circle and the outlet should
become blue (on Linux, the cursor changes from a hand to an arrow, with a small circular symbol next to it).
Click and drag. You will see a line coming out the outlet of the message. When holding the mouse click
down, if you hover over the left inlet of the object, the cursor will again become a circle and the inlet will
become blue. Let go of the mouse click, and the line will stay between the message and the object. You have
now made your first connection.

What we have until now is a patch, but it doesn’t really do anything. We need to put at least one more
object for it to work. Again, put an object in your patch (preferably with the shortcut instead of using the
menu) and place it below the [osc~] object (using square brackets indicates a Pd object when Pd patches

4
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are explained in text). This time, type dac~. This object has two inlets and no outlets. This is actually your
computers’ left and right speakers. Connect the outlet of [osc~] to both inlets of [dac~], the same way you
connected the message to [osc~]. Your patch should look like the one in Figure 1-7.

440
" o

OSC~

)

dac~

Figure 1-7. A simple Pd patch

You might notice that the connections that come out from [osc~] are thicker than the one coming
out from the message. These are signal connections, whereas the thin one is a control connection. The
difference is the same as with signal/control objects.

Now we have a fully functional patch. In order to make it work, we need to take another two steps. First,
we need to get out of Edit Mode. Go to the Edit menu and you'll see Edit Mode; it is ticked, which means that
you are in this mode. If you click it, the cursor will turn from a little hand to an arrow. This means that you
are no longer in Edit Mode and cannot edit the patch, but you can interact with it. If you go to the Edit menu
again, you'll see that Edit Mode is not ticked anymore. From now on, we'll use the shortcut for Edit Mode,
which is Ctrl/Cmd+E. The last thing you need to do to activate the patch is to turn on the DSP. Go to
Media » DSP On (Ctrl+/or Cmd+/). On the Pd console, there is a DSP tick box. To turn on the DSP, select
the tick box; DSP becomes green, as shown in Figure 1-8. When the DSP is on, all signal objects are activated.
Make sure to put your computer’s volume at a low level before you turn the DSP on, as it might sound
rather loud.

~ DSP
Figure 1-8. DSP on indication on Pd’s console

Even though you turned on the DSP, you still hear nothing. Hover the mouse over the message (you'll
see the cursor arrow change direction, which means that you can interact with the element you hover your
mouse over) and click. Voila! You have your first functional Pd patch! This is a very simple program that plays
a sine wave at a 440 Hz frequency.

Before getting overly excited, it’s good practice to save your first patch. Before you do that, you might
want to turn the DSP off by going to Media » DSP Off (Ctrl/Cmd+.) Now the DSP tick box should be unticked.
Saving a patch is done the same way that you save a text file. Go to File » Save As... (Shift+Ctrl/Cmd+S) and
a dialog window will open. Here you can set a name for your patch (that could be my_first_patch) and a place
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to save it. If you haven’t done so yet, create a folder somewhere in your computer (a good place is Documents/
pd_patches, for example, definitely not the Program Files folder) and click Save. It’s good practice to avoid
using spaces both in Pd patch names and folders used by Pd, as it’s pretty difficult to handle them. It’s better
to use an underscore (_) instead. Also, notice the file extension created by Pd, which is . pd (not too much of a
surprise...). These are the files that Pd reads.

Now that we've saved our first patch, let’s work on it a bit more. Go back to Edit Mode (Ctrl/Cmd+E) to
edit your patch. The cursor should again turn to a little hand. Now we’ll replace the message with another
element of Pd, the number atom. First, we’ll need to delete the message. To do this, drag your mouse and
select it, the same way you select it to move it around. Hit Backspace and the message (along with its
connections) will disappear. Go to Put » Number (Ctrl/Cmd+3) and the number atom will be added to your
patch, which is shown in Figure 1-9.

4

Figure 1-9. A number atom

Connect its outlet to the left inlet of [osc~] (it actually replaces the message) and get out of Edit
Mode. Turn the DSP on and again you'll hear the same tone as before. This is because [0osc~] has saved
the last value it received in its inlet, which was 440. Click the number atom and type a number (preferably
something different than 440) and hit Return (a.k.a. Enter). You have now provided a new frequency to
[osc~] and the pitch of the tone you hear has changed to that. Another thing you can do with number atoms
is drag their values. Click the number and drag your mouse. Dragging upward will increase the values and
dragging downward will decrease them. You should hear the result instantly. When done playing, turn off
the DSP and save this patch with a different name from the previous one.

The Control Domain

Our next step will be dealing with the control domain. As mentioned, the control objects are independent of
the DSP and run their functions only when they are instructed to do so, regardless of the DSP being on or off.
Let’s create a simple patch in the control domain. Let’s open a new window and put an object in it. Inside the
object type +. This is a simple addition object. It has two inlets and one outlet, because it adds two numbers
and gives the result of the addition. Now put three number atoms and connect two of them to each inlet of [+ ]
and the outlet of [+ ] to the inlet of the third number. Make sure that your patch is like the one in Figure 1-10.

2 @
Z:r"p
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8

Figure 1-10. A control domain patch
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Go out of the Edit Mode (from now on we'll refer to this action as “lock your patch”) and click the top-right
number. Type a number and hit Return. Doing this gives no output. Providing a value to the top-left number,
will give the result of the addition of the two values, which is displayed on the bottom number atom. What
we see here are the so-called cold and hot inlets in action. In Pd, all control objects have cold and hot inlets.
No matter how many inlets they have (unless they have only one), all of them but the far left are cold. This
means that providing input to these inlets will not give any output, but will only store the data in the object.
The far left inlet of all control objects is hot, which means that providing input to that inlet will both store the
data and give output. This is a very important rule in Pd, as its philosophy is a right-to-left execution order.

It might take a while to get used to this, and not bearing it in mind might give strange results sometimes; but
as soon as you get the grasp of it, you'll see that it is a very reasonable approach to visual programming.

Execution Order

Before moving on to some other very important aspects of Pd, I should talk a bit more about the order of
execution, since you saw a small example earlier. In a new patch, put a number atom and put an object
below it. Type * inside the object. This is a multiplication object, which works in a way similar way to the
addition object you saw. Connect the number to both inlets of [* ], but first connect it to the left inlet of [* ]
and then to the right one. Put another number and connect the outlet of [* ] to the inlet of the new number.
You should have the patch shown in Figure 1-11.

loH *?Ica[l

Figure 1-11. A fan out connection

Asyou can imagine, this patch gives the square of a given number by multiplying it to itself. Lock your
patch and type the number 2 in the number atom. What you would expect to receive is 4, right? But instead,
you got 0. Now type 3. Again, you would expect to get 9, but you got 6. Now type 4. Instead of 16, you got 12.

Even though I said that Pd executes everything from right to left, another rule is that execution will
follow the order of connection. That means that if you connect the top number atom to the left inlet of [* ]
first, and then to the right one, whatever value you provide through the number atom will first go to the left
inlet of [* ] and then to the right. But I've already mentioned that all left inlets in all control objects are hot,
and all the rest are cold. So what happens here is that when we gave the number 2 to [*], it went first to the
left inlet and we immediately received output. That output was the number provided in the left inlet, and
whatever other value was stored in [* ]. But we hadn’t yet stored any value, so [* ] contained 0,' and gave the
multiplication 2 * 0 = 0. Immediately after this happened, the number 2 went to the right inlet of [* ] and was
stored, but gave no output, as the right inlet is cold. The next time we gave input to [* ], we sent the number 3.

'In contradiction to many programming languages, Pd has 0 when no argument is provided, instead of NULL.
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Again, we got the same behavior. [* ] first gave the multiplication of 3 by the number already stored, which
was 2 from the previous input, so we got 3 * 2 = 6; and then the number 3 was stored in [* ] without giving
output. The same thing happened with as many numbers we provided [* ] with.

If we had connected the number atom to the right inlet of [* ] first and then to the left one, things would
have worked as expected. But connecting one element to many can be confusing and lead to bugs, which
can be very hard to trace. In order to avoid that, we must force the execution order in an explicit way. To
achieve this, we use an object called trigger. Disconnect the top number atom from [* ] and put a new object
between them. In it, type t £f. “t” is an abbreviation for trigger and “f” is an abbreviation for float. A float in
programming is a decimal number, and in Pd, all numbers are considered decimals, even if they are integers.
[t ff] has one inlet (which is hot) and two outlets. Connect the top number atom to the inlet of [t f f] and the
outlets of [t ff] to the corresponding inlets of [* ]. You should have a patch like the one shown in Figure 1-12.

-+

f
ﬁF

loH *H~HeD

Figure 1-12. Using [trigger] instead of fan out

[t ff] follows Pd’s right-to-left execution order, no matter which of its inlets gets connected first. Now
whichever number you type in the top number atom, you should get its square in the lower number. This
technique is much safer than the previous one and it is much easier for someone to read and understand. By
far, it’s preferred over connecting one outlet to many inlets without using trigger, a technique called fan out.

Bang!

It’s time to talk about another very important aspect of Pd, the “bang” The bang is a form of execution order.
In simple terms, it means “do it!” Imagine it as pressing a button on a machine that does something—the
elevator, for example. When you press the one and only button to call the elevator, the elevator will come to
your floor. In Pd language, this button press is called a bang. In order to understand this thoroughly, we’ll
build a simple patch that counts up, starting from zero. Open a new window and put two objects. In one of
them, type f, and in the other + 1 (always use a space between object name and argument). “f” stands for
float, as in the case of [trigger], and [+ 1] is the same as [+ | we have already used, only this time it has an
argument, so we don’t need to provide a value in its right inlet. Whatever value comes in its left inlet will be
added to 1 and we’ll get the result from its outlet. Connect these two objects in the way shown in Figure 1-13.



CHAPTER 1 © INTRODUCTION TO PURE DATA

f +1'.=

Figure 1-13. A simple counter mechanism

Take good care of the connections. [f] connects to the left inlet of [+ 1], but [+ 1] connects to the right
inlet of [f]. If you connect [+ 1] to the left inlet of [f], then you'll have connected each object to the hot inlet
of the other. In this case, as soon as you try to do anything with this, you'll get what is called a stack overflow,
as this will cause an infinite loop, since there will be no mechanism to stop it.

Above these two objects put a message and type bang in it. Connect its outlet to the inlet left of [f].
Lastly, put a number atom below the two objects and connect the outlet of [f] to it. You should have the
patch in Figure 1-14.

Tj'ang

a v -
f + 1
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=
Figure 1-14. A simple Pd counter

Note that, even though in the previous section I mentioned the importance of using [trigger], here we're
connecting [f] to two objects (one object and one number atom) without using [trigger]. This specific kind of
patch is one of the very rare cases where execution order doesn’t really matter, so we can omit using [trigger].
Still, in most cases it is really not a good idea not to use it.

What we have now created is a very simple counter that counts up from zero (it starts from zero because
we haven’t provided any argument to [f ], and as already stated, no argument defaults to zero). [f ] will go to
[+ 1], which will give 0 + 1 = 1. This result will go to the right inlet of [f ], meaning that the value will only be
stored and we'll get no output. The value that comes out of [f] will also go to the number atom, where it will
be displayed. The next time [f] will throw its value, it will be 1, which will go to [+ 1], which will give 1 + 1 =2,
which will be stored in [f], and 1 will be displayed in the number atom, and so on.

For [f] to output its value, it must receive some kind of trigger. This is where the “bang” comes in. Lock
your patch and click the message. The first time you'll see nothing because [f | will output zero, but the
number atom displays zero by default. Hit the message again and you'll see the value 1 in the number atom.
The next time you hit the “bang” message, you'll see 2, and so on.

This is how we create a simple counter, which a very valuable tool in programming—for example,
when building a sequencer, which we'll do in Chapter 4. We've also seen bang in action, a very important
aspect of Pd.
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Comments

In programming, one common element between different languages is the comment. A comment is just
this, a comment. It’s there to provide information about some features of a program or a part of it. Pd is no
different when it comes to comments. In a new patch, go to Put » Comment (Ctrl/Cmd+5) and the word
“comment” will appear, following your mouse. As with all other elements, click so that it stops following the
mouse. By clicking, you'll also see a blue rectangle around the comment. This means that you can edit it.
Go ahead and type anything you want. Figure 1-15 shows a Pd comment.

this i1s just a comment, it does nothing else than display
the text typed in it.

Figure 1-15. A Pd comment

From the early stages in programming learning up to professional programming, it is typical to see
comments, which are extremely helpful. Comments help others understand your programs more easily, but
also help you to understand your own programs when you come back to them some time after you've made
them. With comments, we covered the most basic and useful elements of Pd.

Getting Help

Pd is a programming language that is very well documented. Even though it’s open source, and nobody

gets paid for creating it, maintaining it, developing it, or documenting it, it still has a great amount of
documentation. When we say documentation, we don’t really mean tutorials in its usual sense, but help
files, which themselves are some kind of short tutorials. Every element, like the object, the message, and so
forth in Pd has a help file, which we call a help patch. To get to it, all you need to do is right-click the element.
You get a menu with three choices: Properties, Open, and Help. The first two are very likely to be grayed out,
so you can'’t choose them, but Help is always available. Clicking it will open a new patch, which is the help
patch of the element you chose. All elements but the object have one help patch, as they do something very
specific (the message, for example, delivers a message, and that’s all it does). But the object is a different case,
as there are many of them in Pd. So, depending on the object you choose (which is defined by the text in it),
you'll get the help patch for that specific object. For example, [osc~] has a different help patch than [dac~].

In a patch, put an object ([osc~] for instance), a message (no need to type anything in it), a number
atom, and a comment (also no need to type anything), and right-click each of them and open their help
patches. In there, there’s text (actually comments) describing what the element does, and providing
examples and other information. Don’t bother to read everything for now, you're just checking it to get the
hang of finding and using help patches. You need to know that you can copy and use parts or the whole
patch into your own patch. Go ahead and play a bit with the examples provided, and if you want, click the
Usage Guide link on the bottom left. This will open a help patch for help patches, describing how a help
patch is structured to get a better understanding of them. Mind that objects starting with pd (for example,
[pd Related_objects]) are clickable and doing so (in a locked patch) will open a window. This is called a
subpatch, which we’ll cover further on.

Lastly, right-clicking a blank part of a patch, will open the same menu, but this time Properties is
selectable. You won't select it now, but instead click Help. This will open a help patch with all the vanilla
objects (you might get some red messages in Pd’s console, called error messages, but it’s not a problem). If
you want, you can go through these, but don’t bother too much, as it might become a bit overwhelming. By
using Pd more and more, you get to know the available objects or how and where to look for what one needs.
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GUIs

The next step is the GUI. GUI stands for graphical user interface. In computers, GUIs are very common.
Actually, Pd itself runs as GUI and your computer system too (most likely). All the windows you open from
various programs are considered GUIs. This approach is usually much preferred over its counterpart, the
CLI (command-line interface), where the user sees only text and interacts with it in a terminal window, for
example.

Even though Pd itself runs as GUI (since it is visual and not textual) there are some elements of it that
are considered to be its GUIs (the elements covered so far, but the number atom are not GUIs). If you click
the Put menu, the second group of elements contains GUIs: the Bang, the Toggle, the Number2, and so forth.
The ones we'll use most are the bang, the toggle, the sliders, and the radios, which you can see in Figure 1-16.

Q <~ this is a Bang
[] < this is a Toggle

<~ this is a Vslider (Vertical Slider)

[ | == this is an Hslider (Horizontal Slider)

<~ this is a VYradio (Vertical Radio)

M JTTTTTJ] = this is an Hradio (Horizontal Radio)

Figure 1-16. The bang, the toggle, the sliders, and the radios

Open a new patch and put a bang from the Put menu (Shift+Ctrl/Cmd+B). This is the graphical
representation of the [bang] (a Pd message in textual form starts with an opening square bracket and ends
with an opening parenthesis, imitating the way it looks in Pd). The Bang is clickable and it outputs a bang.
Right-click it and open its help patch (here the Properties are not grayed out and are selectable, but we won’t
delve into this for now). On the top-right of the help patch, there’s an object [x_all_guis....]. Clickitand a
new window will open with all the GUIs in Pd. From there you can right-click each and check its help patch
to see what it does. Focus on the GUISs that we’ll typically use, which I've already mentioned. Let’s talk a bit
about these.

11
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We've already covered the Bang, so let’s now talk about the Toggle. The Toggle functions like a toggle
switch; it’s either on or off. It's a square, and when you click it (in a locked patch), an X appears in it. That’s when
it'’s on. When there’s no X in it, it’s off. By “on” and “off” here, I mean 1 and 0. What the Toggle actually does is
output a 1 and a 0 alternately when clicking it, and we can tell what it outputs by the X that appears in it.

The Slider (Vslider stands for vertical slider and Hslider for horizontal slider) is a GUI imitating the
slider in hardware; for example, in a mixing desk. Clicking and dragging the small line in it outputs values
from 0 to 127 by default, following the range of MIDI; but this can be changed in its properties. You can get
these values from its outlet.

The Radio (again Vradio and Hradio stand for vertical and horizontal) works a bit like a menu with
choices (like the one that appears when you right-click a Pd element). Only instead of text, it consists of little
white squares next to each other, and clicking them outputs a number starting from 0 (clicking the top of the
Vradio will output 0, clicking the one below will output 1, and so forth). The Hradio counts from left to right.
You can tell which one is currently clicked by a black square inside it. It doesn’t really sound like a menu, but
remember that Pd is a programming language, meaning that we need to program anything we want it to do.
This way, provided a very simple GUI that outputs incrementing values, we can use it to create something
more complex out of it. We'll see it in action in the interface building projects in this book. We've now
covered the GUIs that we will use and we can move on.

Pd Patches Behave Like Text Files

When we edit a Pd patch, we can use features that are common between text editing programs. This means
that we can choose a certain part of the patch (by clicking and dragging in Edit Mode), copy it, cut it,
duplicate it, paste it somewhere else in the patch, or in another patch. If you click the Edit menu, you'll see
all the available options.

The ones we’'ll mostly use in this book are Copy (Ctrl/Cmd+C), Paste (Ctrl/Cmd+V), Cut (Ctrl/Cmd+X),
and Duplicate (Ctrl/Cmd+D). Actually, a Pd patch is text itself. If you open any patch in a text editing
program, you'll see its textual form. The first patch we created in this chapter, with the [440] message and
[osc~] and [dac~], looks like what’s shown in Figure 1-17.

#N canvas 384 273 450 300 10;
#X msg 161 69 440;

#X obj 161 91 osc~;

#X obj 161 113 dac~;

#X connect 0 0 1 0;

#X connect 1 0 2 0;

#X connect 1 0 2 1;

Figure 1-17. A Pd patch in its textual form

Even though this is pretty simple, you don’t really need to understand it thoroughly, as we’re not
going to edit patches in their textual form in the course of this book. Still, it’s good to know what a Pd patch
really is.

12
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Making Oscillators in Pd

Now that we've covered the real basics of Pd, and you know how to create patches, let’s look at some
sound generators that we will use in later chapters. First, I need to explain what an oscillator is. In analog
electronics, it is a mechanism that creates certain patterns in an electrical current, which is fed to the
sound system, causing the woofers of the speakers to vibrate in that pattern, thus creating sound. In digital
electronics, this mechanism consists of very simple (or sometimes more complex) math operations (here
we're talking about multiplication, addition, subtraction, and division, nothing else) that create a stream
of numbers that is fed to the sound card of a computer, turning this number stream to an electrical current.
From that point on, up to the point the electrical current reaches the sound system’s speakers, everything
is the same between analog and digital electronics. The patterns that the oscillators create are called
waveforms, because sound is perceived in auditory waves.

There are four standard waveforms in electronic music, which we will create in this section. These are
the sine wave, the triangle, the sawtooth, and the square wave. They are called like this because of the shapes
they create, which you can see in Figure 1-18.

Figure 1-18. The four standard oscillator waveforms: the sine wave, the triangle, the sawtooth, and the
square wave

Some other audio programming environments have classes for all these waveforms, but Pd has an
object only for the first one, the sine wave. Some consider this to be a bad thing, but others consider it to be
good. Not having these oscillators available means that you need to build them yourself, and this way you
learn how they really function, which is very important when dealing with electronic music. The object for
the sine wave oscillator is [osc~], which you've already seen, so we're not going to talk about it here.

Before moving on to the next waveform, we need to talk about the range of digital audio. Audio in
digital electronics is expressed with values from -1 to 1 (remember, a digital signal is a stream of numbers
representing the amplitude of an electric signal). In the waveforms in Figure 1-18, -1 is expressed by the
lowest point in the vertical axis, and 1 by the highest (waveforms are represented in time, which lies at the
horizontal axis). Paralleling this range to the movement of the speaker’s woofer, -1 is the woofer all the way
in, 1 is the woofer all the way out, and 0 is the woofer in the middle position (this is also the position when
it’s receiving no signal). Figure 1-19 represents these positions of the woofer by looking at it from above.

woofer all the way out = 1

woofer's middle position = 0
.

woofer all the way in = -1

Figure 1-19. The speaker's woofer's positions and their corresponding digital values
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Making a Triangle Wave Oscillator

Now to the next wave form, which is the triangle. We will create this with simple objects. The driving force
for every oscillator (and other things we’ll build along the way) is the [phasor~]. [phasor~] is a rising ramp
that looks like the sawtooth wave form, only it outputs values from 0 to 1. To create a triangle out of this, we
need a copy of [phasor~]; but instead of rising, we need it to be falling from 1 to 0. To achieve this, we must
multiply [phasor~]’s output by -1 and add 1. This is very simple math if you think about it. If you multiply
[phasor~]’s initial value, which is 0, by -1, you'll get 0, and if you add 1 you'll get 1. If you multiply [phasor~]’s
last value, which is 1, by -1, you’ll get -1, and if you add 1, you'll get 0. All the values in between will form the
ramp from 1 to 0. Mind, though, that we are now in the signal domain and all the objects we’ll use are signal
objects. So for multiplying, we’ll use [*~ | and for adding we'll use [+~ | .

Once we have the two opposite ramps, we’ll send them both to [min~]. This object takes two signals and
outputs the minimum value of the two. The two ramps we have intersect at the value 0.5 during their period
(a period in a wave form is one time its complete shape, like the preceding wave form images). For the first
half of the period, the rising [phasor~] is always less than the falling one (the rising one starts from 0 and the
falling from 1), so [min~] will output this. For the second half of the period, the falling [phasor~] will be less
than the rising one, so [min~] will output that. What [min~] actually gives us is a triangle that starts from 0,
goes up to 0.5, and comes back to 0. Figure 1-20 illustrates how this is actually achieved.

falling ramp

[min~]'s output

Figure 1-20. Getting a triangle out of two opposite ramps

AsI've already mentioned, the range of oscillators is from -1 to 1. This is 2 in total. So, multiplying
the output of [min~] by 4, will give us a triangle that goes from 0 to 2. Subtracting 1, will bring it to the
desired range. These last two actions—the multiplication and the subtraction—are called scaling and offset,
respectively. So, our triangle oscillator patch should look the patch in Figure 1-21.

14



CHAPTER 1 © INTRODUCTION TO PURE DATA

hasor~

|

+ 1

I HxH=
e e s
-

By S T

Figure 1-21. The triangle oscillator Pd patch

Connect a number atom to [phasor~] to give it a frequency (lock your patch before trying to type a
number into the number atom) and place a [dac~] and connect [-~ 1] to it. Turn on the DSP and listen to this
wave form. Compare its sound to the sound of [osc~]. The triangle wave form is brighter than the sound of
the sine wave, which is because it has more harmonics than the sine wave. Actually, the sine wave has no
harmonics at all, and even though it is everywhere in nature, you can only reproduce it with such means, as
you can't really isolate it in nature.

Note that execution order doesn’t apply to the signal domain, because signal objects calculate their
samples in blocks, and they have received their signals from all their inlets before they go on and calculate
the next audio block.

Making a Sawtooth Oscillator

The next waveform we’ll build is the sawtooth. This one is very easy, since we'll use [phasor-~], which is itself
a sawtooth that goes from 0 to 1, instead of -1 to 1. All we need to do here is correct its range, meaning apply
scaling and offset. Since [phasor~] has a value span of 1, and oscillators have a value span of 2, we have to
multiply its output by 2; so now we get a ramp from 0 to 2. Subtracting 1 gives us a ramp from -1 to 1, which
is what we essentially want. The patch is illustrated in Figure 1-22.
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Figure 1-22. The sawtooth oscillator Pd patch

Supply [phasor~] with a frequency and connect [-~ 1] to [dac~] to hear it. Compared to the two previous
oscillators, this one has even more harmonics, which you can tell by its brightness; its sound is pretty harsh.

Making a Square Wave Oscillator

Finally, let’s build the last wave form, the square wave. This oscillator is alternating between -1 and

1, without any values in between. Again, we’ll use [phasor~] to build it. Now we’ll send [phasor-~] to a
comparison object, [<~ ], which compares if a signal has a smaller value than another one, or a value
smaller than its argument (if one is provided). If the value is smaller, [<~ ] will output 1, else it will output 0.
Connecting [phasor~] to [<~ 0.5] (don’t forget the space between the object name and the argument), will
give 1 for the first half of [phasor~]’s period, and 0 for the other half, because [phasor~] goes from 0 to 1,
linearly. Multiplying this by 2 and subtracting one will give an alternating 1 and -1, which is what the square
wave oscillator is.

This oscillator has one more control feature, which is how much of its period it will output a 1, and how
much it will output a 0 (for example, it can output a 1 for 75% of its period and a 0 for the rest 25%, or vice
versa, or any such combination). This is called the duty cycle, which is easy to make in Pd. All you need to do
is control [<~ ] with a value that ranges from 0 to 1 (actually from something over 0, like 0.01, to something
less than 1, like 0.99). If you connect a number atom to the right inlet of [<~ 0.5] you'll override the argument
with whatever number you provide (mind that the right inlet of [<~ 0.5] is a control inlet, and that is because
you have provided an argument. If you create the object without an argument, both its inlets will be signal
inlets). Your patch should look Figure 1-23.
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Figure 1-23. The square wave oscillator Pd patch

Try some different values by typing into the number atom (in a locked patch), always staying
between 0.01 and 0.99. You can also hold down the Shift key and click and drag the number atom. This way,
it will scroll its values with two decimal places.

Mind that it is possible to create the same oscillator with [>~ | instead of [<~ ]; the only difference is that
it will first output -1 and then 1, but that’s a difference that is not recognizable by the human ear. Comparing
this oscillator to the others, we see that this one also has a lot of harmonics, as its sound is very bright.

We have now created the four basic oscillators of electronic music. Their raw continuous sound might
not be very musical or inspiring, but the way we’ll use them in some of this book’s projects will be quite
different and will provide more musical results.

Using Tables in Pd

The next feature we're going to look at is tables. You'll learn how to use them in Pd. You learned about
tables in school math; a table stores values based on an index. In Pd, this is either called a table, and you
can create it with [table], or array, which we can put from the Put menu. Open a new window and go to
Put » Array (there’s no shortcut for this one). A properties window will open, where you can set its name,
its size, whether you want to save it contents, the way to draw its contents, and whether to put the array in
anew or in the last graph. From these options, you'll only deal with the first three. For now, you can keep
the default name, which is arrayl. You'll also keep the size for now, which is 100, but you’ll untick the Save
contents field, because we don’t care to save whatever you'll store in it.

Click OK and you'll see a graph in your patch. If you move it, you'll also see its name projected on top of
it, looking like the one shown in Figure 1-24.
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arrayl

Figure 1-24. A Pd array

Inside the array’s window, there’s a straight line, right in the middle, spanning from left to right. These
are the values stored in the array, all of which are 0 for now. The values in an array are graphed in the Y axis
and the indexes in the X axis. Indexes start counting from 0 and go from left to right. In our case, the last
index is 99, as we have an array of size 100 and the first index is 0.

There are a few ways to store values in an array. The simplest one is to draw values by hand. Lock you
patch and hover the mouse over the line in the middle of the array. Click and drag (both up and down, as
well as right and left) and you'll see that the line follows the mouse. This way is not very useful because you
generally want to store certain patterns in arrays that are actually impossible to draw by hand.

Another way to store values is by using [tabwrite], where “tab” stands for table. This object has two
inlets and no outlet. The right inlet sets the index and the left sets the value. It also takes an argument, which
is the name of the array to write to. Put a [tabwrite array1] to your patch and connect a number atom to
each inlet. Lock your patch and store a value to an index; for example, store 0.75 to index 55 (indexes are
always integers). Mind to first provide the index to the right inlet, and then the value—again, the right to left
execution order and hot and cold inlets apply. You should immediately see the dot at the 55" place jump
to the value 0.75 (a bit lower than the upper part of the frame). To double-check it, put a [tabread arrayl1],
which reads values from an array. This one has one inlet and one outlet. In the inlet. you provide an index
and it spits the value at that index out its outlet. Give it the value 55 and it should give 0.75.

All of this isn’t likely very intuitive and the point might seem a bit hidden. Let’s look at another way to
use arrays. Right-click Array and click Properties. Now you get two windows, but we only care about the first
one. Change the size of the array to 2048, click OK, and close both of these windows (whatever values we’ve
already stored will shrink to the right, as there are now in the very first indexes). Copy one of the oscillator
patches (the triangle, for example) built in the previous section, but instead of [dac~] at the bottom, put
[tabwrite~ array1] (mind the tilde that makes it different from [tabwrite array1]). Connect a number atom
to [phasor~] and a bang (Shift+Ctrl/Cmd+B) to [tabwrite~ array1] (this object has one inlet only and it takes
both signals and bangs). Figure 1-25 shows what your patch should look like.
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Figure 1-25. The triangle oscillator connected to [tabwrite~] in order to be stored in an Array

Provide a frequency via the number atom (don'’t forget to lock you patch), turn the DSP on and click the
Bang ([tabwrite~] will store any signal connected to its inlet, whenever it receives a bang). You should see the
wave form of the oscillator stored in the Array, similar to Figure 1-26.

arrayl

Figure 1-26. The triangle oscillator wave form stored in an array

You can display all four oscillators we’ve already made to see their shape in action.

Another very useful feature of tables in Pd is that we can upload existing audio files to them. Create the
patch in Figure 1-27. [tabplay~] is designed to play audio stored in a table. Clicking the top bang will open a
dialog window, where you can navigate to a folder where you have an audio file (a .wav or .aiff file, no .mp3)
Once you select an audio file (not a very long one, up to 5 minutes, more or less; usually tables have files that
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are a few seconds), click Open and you'll see the wave form of your audio file appear in the array (the longer
the file, the longer it will take for the array to display it). Here we don’t need to mind about the size of the
array, because it will automatically get resized according to the length of the audio file. Turn the DSP on and
click the lower bang, and you'll hear the audio file you just inserted. This is the simplest way of playing back
audio files, but also the one with the least features. In later chapters, you'll see other ways to reproduce audio
files that give more freedom to manipulate them.

ﬁbng <~ click to upload audio file

e
£Penpanel arrayl
read -resize $1 arrayl

gpundfiler

bang <~ click to play audio file
tabp lay~ arrayl

;. e

dac~

Figure 1-27. An audio file playback patch

So you can see that tables can be very useful as, apart from other data, you can also store and play back
audio. We'll use arrays to store and manipulate sound in some of this book’s projects.

Subpatches and Abstractions

Since you've done a little bit of patching, we can now talk about tidying up our patches. As your patches
grow more and more complex, you'll see that having all objects, messages, number atoms, and so forth,
visible in your patch will be more and more difficult. It will also be difficult to keep track of what each part of
your patch does. This is where the subpatch comes in. A subpatch is an object that contains a patch. Open
anew window and put an object. Inside the object type pd percentage. (We’'ll make a subpatch that gives a
percentage value, although the name of the subpatch could be anything. Naming it “percentage” makes it
clear as to what the subpatch does.) A new window will open, titled “percentage” This window is a Pd patch,
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more or less as you already know it. The only difference between this and a normal Pd patch is that the
subpatch cannot be saved independently from the patch that contains it, which is called the parent patch.
A subpatch is part of its parent patch, and will be saved only if you save the parent patch.

Using subpatches is very useful for tidying up our patches, and helps us create programs in a
self-explanatory way. We can put any Pd element in a subpatch, but in order to have access to it, we need to
use [inlet] and [outlet]. In the “percentage” subpatch, put an object and type inlet. If you look at the parent
patch, [pd percentage] now has one inlet. If you put more [inlet]’s in the subpatch, you’ll see them in the
parent patch object. The same goes for the [outlet]. The order of their appearance in the parent patch follows
the order of their placement inside the subpatch, meaning that the far left [inlet] in “percentage” is the far
left inlet in [pd percentage] in the parent patch. Let’s see the subpatch in action. Inside the subpatch put the
objects, as shown in Figure 1-28.

inlet give percentage inlet 9ive value
Z:— =
*

L =
/ 168

'

out let

Figure 1-28. Contents of the “percentage” subpatch

This subpatch calculates a given percentage of a given value, where the percentage goes into the left
inlet and the value into the right one. Lock it and close it.

In the parent patch, you should have a [pd percentage] with two inlets and one outlet. The left inlet
of [pd percentage] corresponds to the left inlet of Figure 1-28. Connect a number atom to each inlet and to the
outlet. Provide a value to get its percentage to the right inlet, for example, 220 (remember that the left inlet of [* ]
is hot, so we need to provide input to the right one first) and the percentage, to the left inlet. Figure 1-29
shows the subpatch in action, where we ask for 40% of 220, and we get 88.

40 220
& &
Ed percentage

88

Figure 1-29. The “percentage” subpatch

This specific subpatch is quite simple, but we have already enclosed two objects in one. The more
complex a function within a patch becomes, the more space we save by placing it in a subpatch, and the
more readable our patch is, since we can give a name to the subpatch that corresponds to its function. This
way we can even avoid writing comments, as our patch is self-explanatory.
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Abstractions are somewhat different than subpatches. They are also Pd patches used as objects, but
instead of creating them inside a parent patch (and saving them only through their parent patch), we create
them independently of any other patch. Abstractions are essentially pieces of code that we very often use,
so instead of making that specific piece of code over and over again, we create it once, and use it as is. Take
a simple example—a hertz-to-milliseconds converter. This is a very simple patch to create; it is shown in
Figure 1-30.

inlet

" - -
swap 1000

T
s

out let

Figure 1-30. Contents of the “Hz2ms” abstraction

In this patch, we provide a value to [swap 1000]. What [swap 1000] does is get a value in its left inlet and
output it out its right inlet, and output 1000 out its left inlet; in three words: swaps its values. Check its help
patch for more information.

Pd’s objects will receive either hertz or milliseconds as time units, so it’s very helpful to have an object
that converts from one to the other. But Pd doesn’t have such an object, and creating this patch (no matter
how simple it is) every time you need to make this conversion would be rather painful. What you can do
is create this patch once and save it to a place where Pd will look at. This is done in a few ways. One way is
to save your abstraction in the same folder with the patch where you'll use that abstraction. This way, the
abstraction will be more project -specific rather than generic. The one in Figure 1-30 is a very generic one.
What we'll do is create a folder called abstractions, inside the pd_patches folder, and set that folder to Pd’s
search path. To do this, go to Edit » Preferences (on OS X, go to Pd-extended » Preferences). You'll get a
window where you can set a search path for Pd. This is shown in Figure 1-31.
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Figure 1-31. Pd's Preferences window

Click New... and a dialog window will open. Navigate to the newly created abstractions folder and
click Choose. In Pd’s Preferences, click Apply. You won't see anything happening, but the search path has
been stored. Then click OK and the window will close. Now save the patch to the abstractions folder with
the name Hz2ms, which stands for “hertz to milliseconds.”

For Pd to be able to use the newly set search path, you must quit it and restart it. Once you restart Pd,
open a new window, put an object, and type Hz2ms. If all goes well, you'll see an object with that name.

If instead of an object you get a red dotted rectangle and a message in Pd’s console, like the one shown
in Figure 1-32, check the search path in Pd’s Preferences, or make sure that you typed the name of the
abstraction correctly.
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Figure 1-32. An error message in Pd’s console

In a locked patch, clicking the abstraction opens the actual patch, like with subpatches. What is different
from the subpatch is that the abstraction is ready to use whenever you launch Pd, and you don’t need to
create it anew every time. Abstractions have more advantages, concerning arguments, name clashes, and
others, but we’re not going into too much detail now.

Both the subpatch and the abstraction have their own purposes, and you can’t say that one is generally
superior to the other. In different occasions, you might need to use one of the two. Also mind that both
can be used in the signal domain by using [inlet~] and [outlet~]. Throughout this book, we’ll use both
abstractions and subpatches.

Control Domain vs. Signal Domain

You've already learned that the signal domain runs for as long as the DSP is on, while the control domain
will run only when it is told to (with a bang, for example). One thing you've also seen is a combination of
the two. In the square wave oscillator patch that you made, you connected a number atom to the right
inlet of [<~ ]. You also connected number atoms to [phasor~] to control its frequency, but that is not really
affected by the difference between the two domains. Usually when you combine the two domains, you get
annoying clicks when you give input from the control domain to the signal domain.

In the case of the square wave oscillator, these clicks are not really audible, because the square wave
form is itself very “clicky.” Let’s take another example, one where you control the amplitude of a sine wave.
Controlling the amplitude of a signal in digital electronics is simple multiplication with values between
Oand 1.

Since a digital signal is a stream of numbers, when you multiply these numbers by 0, you'll get a constant
0 (remember the woofer’s positions; this would be silence). Multiplying the number stream by 1 will give
you the number stream intact, hence the signal in its full amplitude. All the values in between will give
corresponding results. Go ahead and build the simple patch, as shown in Figure 1-33.

24



CHAPTER 1 © INTRODUCTION TO PURE DATA

Escfv 44'B=

7 127
e

dac~

Figure 1-33. Controlling the amplitude of an oscillator

You're dividing the output of the Hslider by 127 to get a range from 0 to 1 (sliders have a default range
from 0 to 127). Turn the DSP on and use the slider (in a locked patch). The more you move it to the right, the
louder you'll hear the sine wave. Pay close attention to these amplitude changes; the faster you move the
slider, the more clicks you hear. This is due to the clash between the control and the signal domain. In detail,
[*~ ] refreshes its values in every new DSP cycle (as all signal objects do), which is done in blocks of
64 samples (no need to really grasp this detail though) Therefore, if you change the slider values quickly,

[*~ ] will make sudden jumps from the previous value to the current, which is heard as a click.

To remedy this, you must make the value changes smoother. There’s a very useful object in Pd for this:
[line-~]. [line~] takes two values: the destination output value and an amount of time in milliseconds. [line~]
will make a linear ramp in the signal rate, from its current value to the destination value, and this ramp will
last as many milliseconds as you provide with the second value. Change the patch in Figure 1-33 to the patch
in Figure 1-34.

'3§c~ 4453
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Figure 1-34. Using [line~] to avoid clicks
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Lock your patch, turn the DSP on, and click the two messages alternately. You should hear the sound
of the sine wave come in and go out without any clicks at all. This is because [line~] makes a ramp from 0 to 1
in 100 milliseconds, and the other way around. This ramp smooths the changes and gets rid of the
annoying clicks.

But what if you want to have a variable amplitude? You can combine the slider in Figure 1-33 with [line~],
as shown in Figure 1-35.
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Figure 1-35. Combining the Hslider with [line~]

$1 in the message means the first value that comes in its inlet. Here we provide one value only, so $1
will take the value of the slider. 100 is still the amount of milliseconds for the ramp of [line~]. Now, no matter
how quickly you move the slider, there are no clicks at all. This is the way to combine the two domains—
something that happens very often in Pd.

Audio Input in Pd

Apart from sound generators, in Pd we can also use audio input, from a microphone for example. We can use
that input in many different ways. We can store it, like we did with the oscillator wave forms, and play it back
in various ways, we can write it in delay lines and use that to play a delayed copy in various ways, we can
apply pitch shifting, and many more. For now, we'll talk about how to receive that input, and we’re going to
play it straight away from the speakers.

The object that receives input from the computer’s sound card is [adc~], which stands for analog-to-
digital converter, which is the opposite of [dac~]. In a new window, put an object and type adc~. You'll get an
object with no inlets and two outlets. The two outlets are the two input channels on your computer’s sound
card. But the default input in Pd is the built-in microphone, which has only one channel. So we can give an
argument to [adc~], which is the channel we want to use; in this case, it’s 1. So click the object to make it
editable, and type adc~ 1 (make sure that you put a space between the name of the object and its argument).
Now the object has one outlet. Put a [dac~] and connect [adc~ 1] to both inlets of [dac~]. If you turn the DSP
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on and your speakers are quite high, you'll get feedback, meaning that the audio that goes out the speakers
will immediately go back in through the microphone, creating a loop, and it will most likely create a high
and rather loud tone. To avoid that, you can use headphones for this patch. Now if you talk close to your
computer’s built-in microphone, you'll hear your voice through the headphones. Maybe the output is a bit
delayed; that is because digital audio takes some time to make its calculations before it outputs sound. In the
following sections, we'll talk about a way to reduce that delay.

Basic Electronic Music Techniques

Now let’s cover some basic electronic music techniques with Pd. We've already created the four basic
oscillators, but now we're going to create some more interesting sounds by using them.

Additive Synthesis

The first technique we're going to look at is called additive synthesis, because we use many oscillators (usually
sine waves) added together to create more interesting timbres. Figure 1-36 shows an additive synthesis Pd patch.
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X~ 0.16666

dac~

Figure 1-36. Additive synthesis Pd patch
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In additive synthesis, if we want to create a harmonic sound, we provide a base frequency, and we
multiply it by the order of each oscillator. For the first oscillator, we multiply it by 1, for the second by 2, and
so forth. Something else we do in the patch shown in Figure 1-36 is set the amplitude of each oscillator to
the reciprocal of its order, so the first oscillator will have full amplitude, the second will have one half of its
amplitude, the third will have one-third, and so forth. Note that multiplying requires less CPU than dividing, so
instead of dividing, we multiply each oscillator’s output by the reciprocal of its order. Mind the multiplication
at the bottom of the patch. When we output more than one signal as they are being added, therefore we must
scale them to make sure that their sum won'’t go over 1 or below -1. To achieve this, we multiply the total
output by the reciprocal of the number of signals we send to the speakers; here it’s 1 + 6 = 0.16666.

The more oscillators we use, the more it will sound like a triangle oscillator, because this is the
algorithm the triangle wave form uses. Still, you need many sine wave oscillators to make them sound like a
triangle. With additive synthesis, we can create more textures by providing frequencies to each oscillator that
are not integer multiples of the base frequency. This will create non-harmonic sounds, but you might find
very interesting textures this way.

Another aspect to experiment with is the amplitude of each oscillator. By changing these, the timbre
of the sound changes drastically. Try some random values between 0 and 1 for each oscillator to hear the
result. The way to create additive synthesis shown here is not the most effective one; usually, we prefer to
use abstractions, as they reduce patching to a great extent. Still, it shows how additive synthesis works rather
clearly. We'll see how to utilize abstractions for additive synthesis in one of this book’s projects.

Ring Modulation

Using a lot of oscillators might give nice results, but it requires a lot of CPU, plus it can be cumbersome to
create some textures. There are techniques that use only a few oscillators (two at least) and can give very
interesting sounds. We'll look into the most basic ones and we’ll start with the ring modulation (RM). This
is a quite simple technique; it is the multiplication of two signals. We’ll use sine waves for all the techniques
in this section, but you can experiment with any wave form we’ve already built. Make the patch shown in
Figure 1-37.

dac~

Figure 1-37. A ring modulation patch
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Lock your patch, turn the DSP on, and start dragging your mouse in the number atoms, or use sliders
instead. (Although you might want to multiply their output to a range other than 127; multiply them by 3,
for example.) You'll start hearing two tones, which are the addition and the subtraction of the two provided
frequencies. For example, if you type 300 in one number atom and 5 in the other, you'll hear the frequencies
305 and 295. Sometimes the subtraction of the two frequencies result in a very low frequency (if, for
example, you provide 305 and 300, you'll get 605 and 5), which are not audible by the human ear. Keep on
dragging your mouse upward till you start hearing two tones. Experiment a bit till you find some interesting
results. You can also combine RM with the additive synthesis patch in Figure 1-36, where one of the two
oscillators in Figure 1-37 will be replaced by the additive synthesis patch.

Amplitude Modulation

The next technique is the amplitude modulation (AM). It is very similar to the ring modulation. Again we
multiply two signals, but we use one signal to modulate the amplitude of the other. As we've already seen,
to modulate the amplitude of a signal, we need to multiply it with values between 0 and 1. But oscillators
give values from -1 to 1. To bring one of the oscillators to the desired range, we need to apply some scaling
and offset. First of all, we need to shrink the oscillator’s range to its half. We do this by multiplying it by 0.5
(remember that multiplication in computers require less CPU than division, so instead of dividing by 2, we
prefer to multiply by 0.5). Multiplying by 0.5 will make the oscillator go from -0.5 to 0.5. If we add 0.5 (this is
the offset), it will go from 0 to 1.

So, the patch in Figure 1-37 changes slightly and becomes the patch in the Figure 1-38.
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Figure 1-38. An amplitude modulation patch

Give a high enough frequency to the left oscillator (depending on your speakers; if you use laptop
speakers, you should give at least 200) and a very low one (like 1) to the right oscillator, which is the
modulator. You should hear the tone of the left oscillator come in and out smoothly. The higher you bring
the modulator’s frequency, the faster these changes will happen. If you bring it too high (above 20), you'll
start getting similar results to the ring modulation. This is because humans can hear frequencies as low as 20
hertz. Using lower frequencies are not immediately audible, but they can effectively change the amplitude of
another audio generator. In this case, the oscillator is called an LFO (low-frequency oscillator). If we provide
a frequency higher than that, then it enters the audible range and we start hearing it immediately (and it’s no
longer an LFO).
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Frequency Modulation

Next in line is the frequency modulation (FM). Here we use one oscillator, called the modulator, to modulate
the frequency of another oscillator. The patch to do this is shown in Figure 1-39.
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Figure 1-39. A Frequency modulation patch

Figure 1-39 includes some comments describing the role of each element. The carrier is the frequency
of the oscillator that we actually hear, which is called the carrier oscillator. The modulator is the frequency of
the oscillator that modulates the frequency of the carrier oscillator. The index is the amount of modulation
the modulator will apply to the carrier. What actually happens is that the frequency of the carrier oscillator
goes up and down, from the carrier frequency + the index, to carrier frequency - the index. If you think
about it, an oscillator outputs values from -1 to 1. Whatever number we multiply this with will give us
the multiplier and its negative. If, for example, we multiply the modulator by 2, it will go from -2 to 2; if
we multiply it by 5, it will go from -5 to 5. This resulting output goes into the right inlet of [+~ ], where it is
added to the carrier frequency, which is steady, and the output of [+~ ] goes into the frequency inlet of the
carrier oscillator. The frequency of the modulator sets how fast these carrier frequency changes will happen.
Figure 1-40 illustrates this.
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Figure 1-40. FM illustration

If the horizontal axis of the graph is 1 second, the carrier frequency is 300, and the index is 50, the carrier
oscillator’s frequency will go from 350 to 250 about three times a second (as many as the peaks in the graph)
in a sine fashion. If the modulator frequency is quite low, what we hear is a vibrato-like sound (especially if we
keep the index low as well). The higher the frequency of the modulator, the less we can tell that the frequency
of the carrier oscillator is actually oscillating, and what we start to perceive is more tones around the carrier
frequency. The higher the index, the broader the spectrum of the resulting sound becomes.

This technique is very common in electronic music, as you can create complex and interesting textures
using only two oscillators. Experiment with all three values and try to find sounds that are interesting to you.

Envelopes

The last technique is the envelope, which we will use for amplitude. The previous four techniques dealt with
timbres by using oscillators in various ways. One thing that none of these techniques included was some
sort of amplitude evolution. Although AM did modulate the amplitude of an oscillator, that modulation

had almost no variation, but a steady oscillating fading in and out. Some musicians tend to treat sound in

a different way, where sounds evolve both in frequency and amplitude, with crescendo, decrescendo, and
similar characteristics. An amplitude envelope is the evolution of the amplitude in time. By applying it to an
oscillator (or to any of the preceding techniques), we can control its amplitude to a great extent, from simple
to very complex ways.

Pd has vanilla objects that can create envelopes, but it can be rather cumbersome and not very intuitive,
especially if someone is not very familiar with programming and Pd itself. For this reason, we’'ll use an
external object that is part of Pd-extended. This object is called envgen (for envelope generator) and it is
part of the “ggee” library. A library is a set of external objects. It is very important to know which library
each external that we use belongs to. To create this object, we need to specify its library, and that is done in
a few ways. For now, we'll use the simplest one, which is to type the name of the library first, then a forward
slash, and then the name of the object. In this case, put an object in a new window and type ggee/envgen.
Figure 1-41 shows what you should get by typing this.
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Figure 1-41. The “envgen” external object from the “ggee” library

This object is actually a GUI, as you might have already guessed. It is designed to work with [line~],
where it sends sequential lists to it. The envelope we’ll design is called the ADSR, which stands for Attack-
Decay-Sustain-Release. It is the most common amplitude envelope that is used in many synthesizers,
commercial or not. The ADSR is a simple imitation of the behavior of the sound of (plucked) acoustic
instruments. The Attach part of it goes to full amplitude in a short time. The Decay part goes down to a lower
amplitude, where it stays for a while, and this is the Sustain. Lastly, the Release goes down to zero amplitude
in a short time. An ADSR envelope is shown in Figure 1-42.

Figure 1-42. An ADSR envelope with [ggee/envgen]

To create this, lock you patch and hover your mouse over the peak of the graph in [envgen], where you
see a small circle. Drag this to the left a bit. To create more breakpoints (that’s what the points where the lines
break are called), click anywhere inside the GUI To move an existing point, click it and drag it, like you did
with the first point. To delete a point, click it and hit Backspace.

The rising part of the envelope in Figure 1-42 is the Attack; the first falling part is the Decay; the
horizontal line is the Sustain’ and the last falling part is the Release. Make the patch shown in Figure 1-43.
The “duration 2000” message sets the duration of the envelope in milliseconds. The bang activates it. Turn
the DSP on, lock your patch, click the “duration” message, and then click the bang message. You should hear
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the sine wave fade in and out in the fashion of the graph of the envelope, which should last two seconds in
total. Go ahead and try different envelopes. Also try them in combination with the other techniques in this

section.

gbng
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Figure 1-43. An ADSR envelope in action

An envelope can be used in any control parameter of a sound, like the frequency, the index in FM, and

so forth.
Figure 1-44 shows a patch where the modulator frequency, the index, and the amplitude of FM
synthesis are being controlled by an [envgen] each. Mind the [trigger], where instead of f, we type b, which

stands for “bang.” In this patch, [trigger]| sends the bang it receives from left to right.
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Figure 1-44. FM with envelopes controlling the modulator frequency, the index, and the amplitude

It is not very important to use here, but it’s good practice to get used to it. With the “duration” message
on the other hand, it is even less important where it will go first, as this message causes no execution at all.
As with the patch in Figure 1-43, lock your patch, click the “duration” message, turn on the DSP, and click the
“bang” message. Experiment with different envelopes and durations.

Note that setting minimum and maximum values for [envgen] can be achieved with arguments. But for
now, we don’t give any arguments and use the object as is, where it defaults to the range 0-1. Check the help
patch to get more information about its use.

We have now covered five basic techniques of electronic music, which we will see later on as build
musical interfaces. We've seen these techniques in their simplest form. In the following chapters, we will
make more efficient, but also a bit more complex, use of them.

Delay Lines in Pd

A delay line is different than the delay mentioned earlier. A delay line delays sound intentionally. Actually,
using delay in many music styles is a much celebrated effect, which has been around for a long time. Pd has
built-in objects for that: [delwrite~], [delread~], and [vd~]. [delwrite~] is a bit like [tabwrite~]; it takes two
arguments though. The first argument is the name of the delay line (like tables, delay lines need to have
names so that we are able to access them), and the second is its length in milliseconds. In the previous patch
with [adc~ 1] and [dac~], disconnect [adc~] from [dac~] and connect it to [delwrite~ my_delay 1000]. This is
a delay line called “my_delay” and it will store 1 second of audio. Apart from its similarity with [tabwrite~],
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[delwrite~] will write on the delay line continuously, as long as the DSP is on. It doesn’t take a bang, and you
can’t control the beginning and ending of writing to the delay line.

[delread~] will read audio from a delay line. It also takes two arguments: the first is the name of the
delay line and the second the delay time in milliseconds. Put a [delread~ my_delay 500] in your patch
and connect it to [dac~]. Figure 1-45 shows what your patch should look like. In this patch, [delwrite~]
takes audio from the built-in microphone of your computer and writes 1 second to the delay line, called
“my_delay” When that second is over, it goes back to the beginning of the delay line and overwrites whatever
was stored there; it does this for as long as the DSP is on. [delread~] reads from that delay line (because its
first argument is the same with the first argument of [delwrite~]), but delays its reading by half a second,
which is the second argument. If the second argument of [delread~] exceeds the second argument of its
corresponding [delwrite~], the delay time is automatically clipped to the length of the delay line (in this case,
1000 milliseconds). If you turn on the DSP and talk into the microphone, you'll hear your voice delayed by
half a second.

adc~ 1

L

delwrite~ my_delay 10060

'ge Iread~ my_delay 500

I\

dac~

Figure 1-45. Simple delay line patch

This might not be a very interesting use of delay, so let’s enhance it a bit. One feature of delay lines is
feedback. What was not desired in the previous section, where we introduced [adc~], is desired when it
comes to delay. If we send the audio read by [delread~] back to its corresponding [delwrite~], along with the
audio that comes in from the built-in microphone, all audio stored in the delay line will be stored again, but
delayed by 500 milliseconds. If we simply connect these two objects, we won’t have any control over it, and
the delay line will keep on writing its own audio back to itself along with the audio that comes in through the
computer’s microphone. To be able to control the feedback, we need to send the output of [delread~] to a [*~ |,
which will control its level, and then to [delwrite~]. Figure 1-46 shows a feedback delay patch.
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Figure 1-46. Feedback delay line patch

As I've already mentioned, the default range of Hslider is from 0 to 127. But multiplying the delayed
sound by such a great number will greatly amplify it and distort it, which might not be so pleasant to your
ears . What we did in a previous example with a slider was to divide its output by 127, so we get a range from
0 to 1. Another way to do that is to use its properties. Right-click it and select Properties. A window like the
one shown in Figure 1-48 will show up. Go to the field named output-rage: and set the value in the right:
field to 1. Click Apply and OK, or simply hit Return. This way, you can have any desired range. It might be
advisable to place a comment next to a slider that has its range changed. When a slider is controlling the
amplitude of a signal that’s coming out through the speakers, it’s rather obvious that its range is from 0 to 1.
Mind that we send the output of the slider to the message [$1 20] and then to [line~]. This is to avoid clicks,
as I mentioned in the “Control Domain vs. Signal Domain” section of this chapter. Turn on the DSP and start
playing with the slider as you talk into the microphone.

[delread~] has one control inlet, which sets the delay time (it will override the second argument). Using
itin real time will create clicks as we combine the control and the signal domain without using [line~] (it’s
not possible to use [line~] here, as the inlet itself is a control inlet). If we want to be able to change the delay
time on the fly, we must use another delay object: [vd~ ]. “vd” stands for variable delay. Change [delread~]
in your patch with [vd~ my_delay]. [vd~ ] takes one argument only, which is the name of the delay line. You
can'’t set the delay time with an argument, but only with input in its inlet. Make your patch look like the one
shown in Figure 1-47.
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Figure 1-47. Delay patch using [vd~ | instead of [delread~]
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Now you can play with both the feedback amount and the delay time. Again, if you're not using
headphones, be careful with the physical feedback that might occur. Mind that we're using [line~] with [vd~ ]
too, in order to avoid clicks.

Before closing this section, let’s make a final enhancement to our delay patch. Let’s use an oscillator to
control the delay time of [vd~ | to see how sound generators can act as controllers. Our patch remains more
or less the same, only the input to [vd~ | changes. Figure 1-49 shows this.
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Figure 1-49. Using an oscillator to control the delay time of [vd~ |

Since oscillators output values from -1 to 1, we apply scaling and offset to get values from 100 to 500
(think of simple math to understand how this is achieved). Give a very low frequency to [osc~], like 0.1 in
order not to get changes in the delay time that are too fast. Turn on the DSP and play with. You'll hear the
delayed audio being repeated faster and faster, and then slower and slower. Also, the faster the repetitions
get, the higher their pitch becomes, and vice versa. Try different oscillators with it to see how it sounds.

Reverb

Reverb is another celebrated effect in lots of music styles. It simulates the depth given to sound in large
rooms. In Pd-extended, there is a vanilla abstraction for reverb called “rev3~". Another option is the
“freeverb~" external, which is also included in Pd-extended. A nice way to test both of these reverbs is to
combine them with the audio file playback patch, shown in the “Using Tables in Pd” section in this chapter.
Check their help patches to see how to use them, and place them (one at a time) between [tabplay~] and
[dac~] (use the arguments of [rev3~] help patch before trying your own values). Better try a rather dry audio
file to hear the full effect of the reverb. We won’t go into more detail about how to make the patch, as by now
you should have gained some fluency in making simple patches.
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Filters

Pd-extended has a variety of raw filters and a few user-friendly ones. The raw filers are [rpole~], [rzero~],
[rzero_rev~], [cpole~], [czero~], [czero_rev~], and [biquad~]. These are quite tough to handle because they
require quite some knowledge on filter theory. Just for the information, “rpole” stands for real pole, and
“cpole” stands for complex pole. You don’t really need to worry about understanding all of this, as a few user-
friendly filters are included as well. These are [lop~], [bp~], [hip~], and [vcf~], where “lop” stands for low
pass, “bp” stands for band pass, “hip” stands for high pass, and “vcf” stands for voltage controlled filter.

[lop~] and [hip~] have one signal and one control inlet. The control inlet takes a frequency value
(which can also be set as an argument), which is called the cutoff frequency. It is called “cutoff” because they
will let all frequencies below or above that pass. The low pass will let the frequencies below the cutoff pass,
and the high pass will let the frequencies above it, hence their names. The left inlet, which is the signal inlet,
takes the signal to be filtered.

[bp~] and [vcf~] are somewhat different. They both have three inlets, the second of which receives the
center frequency. It is called like that because they both let a band around that frequency pass (hence “band
pass”). The right-most inlet takes the so-called Q, which is the width of the band of the frequencies that pass.
Both of these values can be set as arguments in the case of [bp~]. [vcf~] takes one argument only, which is
the Q. The difference between [bp~] and [vcf~] is that the latter can have its center frequency controlled by a
signal (an oscillator for example); whereas [bp~] takes a signal only in its far-left inlet, which is the signal to
be filtered, like with [lop~] and [hip~], and both the center frequency and the Q inlets are control inlets.

[biquad~] is not considered a raw filter, but it’s still difficult to handle. It takes a list of five parameters,
and can more or less take the form of any kind of filter (low pass, shelving filters, and others). You need to
know how to calculate the five coefficients to design the desired filter. Since it is not very user-friendly, we
won't be using it in this book.

An obvious way to use these filters is to filter out some high, low, or middle frequencies of a sound.
Again, you can test them with a sound file, like you did with the reverb. Another way to use these filters is
with oscillators to shape their wave forms. Figures 1-50 and 1-51 show a square wave and a triangle wave
oscillator, respectively, passed through a low pass and a band pass filter, respectively. If you want to build
these two patches, go to the properties of each array. Give each the appropriate name (“unfiltered” and
“filtered”) and change their size to 512. Don’t have both patches open at the same time, as you will have each
array twice, using the same name, and that will create a clash and warning messages in Pd’s console. [metro]
is an object that outputs bangs in time intervals provided via its argument (or its right inlet) in milliseconds.
Check the help patch for more information.
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tabwrite~ filtered

metro 103’
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Figure 1-50. A square wave oscillator passed through a low pass filter

tabwrite~ filtered

metro 108

unfiltered

filtered

Figure 1-51. A triangle wave oscillator passed through a band pass filter
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You can see how the shape of the oscillator changes drastically when filtered. This might be desirable
for the immediate audio result, but also for using them as controllers in various techniques, like FM. Go
back to the “Basic Electronic Music Techniques in Pd” section and try the patches shown there, with filtered
oscillators. You'll see that the variety of sounds you can create will expand greatly.

Before we close this section, let’s show [vcf~] in action and its advantage of being able to control its
center frequency with signals. Build the patch shown in Figure 1-52. The [pd triangle~] subpatch contents
are shown in Figure 1-53, although by now you should be able to tell without being shown.
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Figure 1-52. [vcf~]in action
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Figure 1-53. Contents of [pd triangle~] from Figure 1-52

The result of this specific patch is definitely for hearing as well, and not only for graphing its output.
What happens is that the center frequency of the filter is being controlled by a triangle oscillator. In Figure 1-52,
the values output from the [pd triangle] subpatch, go from 0 to 600, in a triangle fashion. The frequency of
the triangle is a little bit above two-thirds of the frequency of the filtered square wave oscillator. This small
difference creates a slowly evolving shift in the timbre. Put a [dac~] in your patch and listen to the result.

Try different values for both oscillators. As you can imagine, this is a kind of modulation, which could be
included in the modulation patches in the “Basic Electronic Music Techniques in Pd” section.

Making Wireless Connections

We've covered most of the basics of Pd, so now we can talk about more generic things. Here we’ll talk about
how to connect objects, messages, numbers, and so forth, wirelessly. Visual programming can be very
intuitive, because of graphing the data flow in a program, but the more complex a patch becomes, the more
difficult it is to read. Figure 1-54 shows a patch that’s pretty messy.
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Figure 1-54. A rather messy patch

Thankfully, Pd provides a way to connect things without the connection cords, and this makes things
alot cleaner. In the control domain, we can connect things wirelessly using [send] and [receive],
abbreviated [s | and [r ]. These objects take one argument, which is the name to send to and to receive from.

A [send my_send] will be heard by a [receive my_send], as shown in Figure 1-55.
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TB receive my_send
send my_send A8

Figure 1-55. A wireless connection

You can have as many [send]s and [receive]s with the same name as you want. Mind that whenever we
use these objects, we'll use their abbreviated aliases, [s ] and [r ].

In the signal domain, things are a bit different. There are the [send~] and [receive~] objects (also
abbreviated [s~] and [r~]), but you can have only one [s~] with many [r~]s. If you want to send many signals
to one destination (the [dac~] for example), you need to use the [throw~]/[catch~] pair, where you can have
many [throw~]s with the same name, sending signals to one [catch~] with that name. Figures 1-56 and 1-57
show the [s~]/[r~] and [throw~]/[catch~] pairs, respectively.
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Figure 1-56. A [s~]/[r~] pair
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Figure 1-57. A [throw~]/[catch~] pair
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As mentioned in the additive synthesis patch, signals sent to one destination are being added. You can
see that in Figure 1-56, where the graph of the signals exceeds the limits of -1 and 1 (the frame of the graph).
When using [throw~]/[catch~] pairs to send sound, make sure that you scale the sum of signals sent to
[catch~] to keep them within limits. If the audio signal limits are exceeded, they will be clipped before they

reach the sound card. So the graph shown in Figure 1-57 will actually look like the one in Figure 1-58, and
the resulting sound will be distorted.
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Figure 1-58. A clipped audio signal

Before we close this section, I'll note that you must be careful when using wireless connections,
as a patch can become difficult to read because the connections are not immediately visible. Wireless
connections are there to facilitate us when a patch becomes too dense or when it is very difficult to use
wired connections for other reasons. Most of the time, they are much less than the wired ones. A good
balance between wired and wireless connections is an optimal goal. But ultimately, this depends on the
programming style of each person.

Another thing to note is that when using one [send] with many [receive]s in the control domain, there
is no way to force the execution order, as the order the [receive]s were created doesn’t have the same effect
as the order of the connections we make (data will go to the first connection made, but not necessarily to
the first [receive] created). Be very careful when using this pair this way. There is an external object that
remedies this situation, [iemguts/oreceive] (iemguts is the name of the library that the external belongs to).

Audio and MIDI Settings

Until now, we have used the default settings for audio, but we haven’t dealt with MIDI at all. The audio
settings let you configure various settings, like the sample rate, the delay (not the same thing as the delay

we saw previously), and the block size. They also let you choose an external sound card and set the number
of channels both for input and output. In general, when you make music with a computer, it is advisable

to have an external sound card. This is for better performance, for more noise-free audio, for having more
than two channels for input and output, and so forth. A discussion on sound cards is beyond the scope of
this book, so I'll presume you already have a sound card and take it from there. If you don’t have one, it’s not
really a problem, but read this section because it is helpful for other things concerning your audio settings.

To change the audio settings in Pd, go to Media » Audio Settings.... The Audio Settings window
will open. There are a few things you can change in this window. The first one is the “Sample rate,” which
defaults to 44100. We'll leave that as is for now, but if you want to play back audio files that have been
recorded in a different sample rate, then you should set that rate here. The next field is the Delay, which
defaults to 20 milliseconds in OS X and Linux, and to 100 on Windows. This is a delay set to give time to the
computer to do its audio calculations. If you have too much latency with your audio input (for example, the
patch with [adc~ 1]), try a smaller number. You should probably set the smallest number that doesn’t distort
the sound.

To test your latency, go to Help » Pd Help Browser and a window will open. In that window, go to
Pure Data » 7.stuff » tools, and double-click latency.pd. A patch will open with instructions on how to
use it. This patch calculates the latency created by Pd and reports interruptions and errors (if your system
doesn’t have enough time to do its calculations). The next field is Block size, which defaults to 64. This is the
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number of samples in each block that the signal objects receive and output. We won'’t really need a different
block size in this book. Note, though, that the smaller the block size, the faster the audio, but the higher the
CPU. We'll also leave the Use callbacks tick box unticked.

All this leads us to the Input device 1: field. If you have no sound card plugged in your computer, Pd will
choose the built-in microphone, as shown in Figure 1-59. If you plug in a sound card, you'll need to restart
Pd, as it’s not going to see the sound card if it is already launched. If your sound card is not chosen by Pd
automatically, click the (0)Built-in Microph menu and a pop-up menu will appear, where you can choose
your sound card (make sure you have the necessary drivers for your sound card, if there are any. You must
install them and make any configurations necessary before trying to use it with Pd).

0 0O Audio Settings

Sample rate: ||44100 Delay (msec): '20 | Block size: | 64 : Use callbacks
[21 Input device 1:| (0)Built-in Microph | Channels: |2
4 Output device 1:| (0)Built-in Output | Channels: |2

Cancel Apply OK

Figure 1-59. The Audio Settings window in Pd

The field below Input device 1: is the Qutput device 1:, which sets the output sound card. You can have
one sound card for input and another for output, if, for example, you want to use the built-in microphone
and use your external sound card’s output.

The Channels fields set the number of channels for the input and the output. If you want to set up a
quadraphonic system, this is where you'll set the number of channels. In all the projects of this book, we’ll
use a stereo setup, so we're not going to change these fields. When you make the setting you want, click
Apply and then OK. It will take a few seconds, and the Audio Settings window will close. Your settings are
now ready and you can use your sound card with Pd.

To set your MIDI devices, go to Media » MIDI Settings... and the MIDI Settings window will open, as
shown in Figure 1-60.

() ()  MIDI Settings

Input device 1: | none
Output device 1: | none

Use multiple devices

Cancel Apply OK

Figure 1-60. The MIDI Settings window in Pd
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As with the audio settings, you need to plug in your MIDI devices before you launch Pd, otherwise it
won't be able to see them. In the MIDI Settings window, you can choose your input and output devices. We'll
barely use any MID], only in Chapter 5, where we’ll build a MIDI keyboard synthesizer, but we're covering
this part in this chapter since you're getting introduced to Pd. Usually, we use only input devices, like MIDI
controllers, keyboards, and so forth, but you might also want to control a MIDI device from Pd (actually, Pd’s
predecessor, Max, was initially made—by Miller Puckette as well— to control a hardware MIDI synthesizer).

In the MIDI Settings window, again you have two fields, Input device 1: and Output device 1:, like in
the Audio Settings. This is where you choose your device. If you have more than one device, first click the
Use multiple devices button and you'll be able to choose more than one device both for input and output.
When you select your devices, click Apply and then OK for your settings to be activated.

MIDI Settings on Linux

Setting your MIDI devices on Linux is a bit different. Launch Pd from the terminal with the -alsamidi flag,
like this:

/usr/bin/pd-extended -alsamidi &

Open Pd’s MIDI Settings from Media » MIDI Settings... and make sure there is at least one port for the
input. If you're using more than one MIDI device, you should set the number of ports appropriately. Click
Apply and OK. Then in a new patch, put [notein] if you're using a MIDI keyboard, or [ctlin] if you're using a
controller with potentiometers. Open its help patch and see if you get input from your device. If you don’t get
input, go back to the terminal and type:

aconnect -lio

This will print the available MIDI devices and software currently plugged in and running on your
computer. In my computer I got the following:

cliento: 'System' [type=kernel]
0'Timer '
1'Announce

client14: 'MidiThrough' [type=kernel]
0'MidiThroughPort-o0'
ConnectingTo:128:0
Connected From: 128:1

client 20: "nanoKEY' [type=kernel]
0 'nanoKEY MIDI 1 '
Connecting To: 128:0
Connected From: 128:1

client 128: 'Pure Data' [type=user]
0 'Pure Data Midi-In 1'
Connected From: 14:0, 20:0
1 'Pure Data Midi-Out 1'
Connecting To: 14:0, 20:0

What I get is that I have a Korg nanoKEY sending to port 0, and Pd receiving in port 0 (it sends to port 1).
The following example connects the nanoKEY to Pd:

aconnect nanoKEY:0 'Pure Data':0
Pd’s name is two words, so you need to place it without quotes.
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A Bit More on MIDI

Since we're talking about MID], let’s talk a bit about how to receive input from various MIDI devices. Data
from MIDI keyboards can be fetched with [notein]. If you provide no argument to it, it will have three outlets
and no inlets. The outlets from left to right are the MIDI note number, the velocity, and the MIDI channel
number. If you know the channel, you can set it via an argument, and [notein] will have only two outlets, for
the first two. We'll see this object in more detail in Chapter 5.

Controllers with sliders and potentiometers send Control Change messages, which can be retrieved
with [ctlin], which stands for control in. Open its help patch and use your already set controller to see the
input it gives. Again this object has three outlets and no inlets, and the outlets give the controller value, the
controller number, and the channel number. The last two can be set via arguments. Check the help patch for
more information. Also, click the [pd Related_objects] subpatch to see all the MIDI objects available in Pd.

Additional Thoughts

Before we move on to the next chapter, I'd like to give a few tips concerning Pd programming. First of all,
make sure that you save your patches in an organized way. Some people prefer to save files depending on the
project; others prefer to have a tree structure of the files in a single program or programming environment.
You might prefer a different way. The more you deal with Pd, the more files you'll save on your computer.
Whether you are a hobbyist or you want to make things with Pd professionally, it’s best that you find a way to
organize your patches that suits you well.

Make sure that your patches are clean. Placing objects here and there will most likely create a chaotic
patch. Try to have your objects aligned as much as you can. Make use of subpatches, and whenever
applicable, abstractions. Try to make your patches self-explanatory (by giving describing names to
subpatches, for example), and wherever this is not possible, use comments to describe what happens in
that specific part of the patch. Even if you know what each object does in a patch, if there are not enough
comments (or no comments at all), it might still be very difficult to understand what happened. This applies
to your own patches too; when you come back to them after some time (even a couple of weeks can be
enough, to make things confusing).

Use [trigger] whenever necessary. This means that wherever one piece of data goes to more than one
destination, and the order matters, always use [trigger|. Not using it will very likely create bugs that are very
hard to trace. Also, it makes the understanding of a patch very difficult, or even impossible. We haven’t seen
all features of this object yet, as apart from forcing the order of execution, it also converts data types (it can
convert a float to a bang, for example), so in the chapters that follow, you'll see that it is a very important and
helpful object.

Try to build simple things and to make them more complicated as you go. Trying to create something
complex and beyond your skills will cause confusion and disappointment. With programming, you can
create amazing things, but it takes time to handle a programming language. Take one step at a time, and try
to take joy even with very simple programs that you build. As already mentioned, learning Pd is a matter of
personal practice, and if you practice it frequently, you'll find yourself building rather complex programs
before you expected.

I should mention that at the time of writing (August 2015), Pd-extended is not being maintained.
Pd-vanilla, on the other hand, is being actively maintained by Miller Puckette, with new features added and
new versions released frequently.

Pd’s community is very active too, with lots of developers running and sharing their own projects. There
has been a discussion among the community as to what route should be taken to either revive or replace
Pd-extended. The prevailing idea for now seems to be one that centralizes external objects in a repository
that you can pull from and add to your Pd-vanilla. Since Pd is open source, this kind of issue is likely to
arise sometimes. But with an active community like the one around Pd, there’s no fear that all issues will be
solved. Still, the current version of Pd-extended is fully functional and can be used at both an amateur and
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a professional level. If you keep using Pd, it’ good to stay up-to-date as to how it is going to be maintained in
the future. You can place yourself on Pd’s mailing list, which you can find on its web site, or you can sign up
on the Pd forum at http://forum.pdpatchrepo.info/.

Conclusion

This concludes the first chapter and the introduction to Pd, a very flexible and powerful programming
environment. In this chapter, you have been introduced to Pd, its philosophy, some of its features,
capabilities, but also to some basic techniques of electronic music in general. Learning how to use Pd is a
matter of personal practice, though.

Later on in this book, we're going to build more complex patches to make musical programs. What this
book will try to provide is basic knowledge on the tools used, but also ways to research when you want to
realize a personal project. The musical projects built here are limited, so they cannot meet every musician’s
needs. What they can do is give inspiration and insight to musicians so that they can realize original projects
of their own. The main focus in this book is to combine the physical world with that of the computer to make
musical interfaces. The basics of this communication will be covered to such an extent, that you will be able
to use these tools in many different ways, much more than the ones shown here.

Next are the Arduino basics, where you will be introduced to its language and some simple circuits, and
to the communication features between Arduino and Pd.
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CHAPTER 2

Introduction to Arduino

In this chapter, we’ll be introduced to the Arduino prototyping platform. As with the previous chapter, if
you're already using Arduino, and you're programming it yourself, feel free to skip this chapter. Mind you,
that apart from the Arduino language itself, we’ll also focus on its serial communication capabilities, in
combination with Pd. This means that we'll be using both ways of serial communication (Serial.println()
and Serial.write()), and we'll analyze the way they work, their differences, as well as their advantages and
disadvantages compared to one another.

By the end of this chapter, you'll be able to

e  Write simple programs for the Arduino for your physical modeling projects
e  Uselooping mechanisms to facilitate your coding

¢ Understand the way serial communication is achieved, and which way to choose
when

e Use the Arduino in combination with Pd and take advantage of each platforms
capabilities

Arduino Jump Start

The Arduino board is a microcontroller that takes input from the physical world, using various sensors, and
uses it in computer programs. It can be used as a stand-alone application, but also in combination with a
computer to realize things that are more complex. The communication between the physical world and the
computer goes also the other way round. The Arduino can give input to the physical world, by using LEDs,
lights, motors, solenoids, and so forth. The Arduino is also a programming environment and a programming
language. The language is built on C++, but has a great set of its own functions. The third element

that comprises the Arduino in its entirety is its community. It has a large community of users, makers,
developers, enthusiasts, that share work and projects between them. It is very similar to the Pd community,
as they are both open source and widely used.

In contrast to Pd, Arduino is a textual programming language, but a very intuitive one. It also runs on all
three major operating systems, like Pd, and its software is for free. Being open source, its hardware is open as
well. All the schematics and circuit designs are open for anyone to use. So, if you have the facilities, you can
build one yourself. That is a difficult task though, and you are encouraged to buy an original Arduino from
your local reseller, or from their web site.

What makes the Arduino so special is not that it’s a microcontroller that uses sensors, or that it can
communicate with a computer to give input from or to the physical world, but the fact that it has been
packaged with its software in such a way that it makes physical computing (the communication between
the computer and the physical world) much easier than ever before. Microcontrollers are said to be a very
difficult field in programming, but the Arduino is very simple to program. Also, the way it is build, facilitates
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prototyping to a great extent, where you can plug in a few sensors and start using them in a matter of a few
minutes. The Arduino has actually revolutionized the way we use microcontrollers and the contributed in
the expansion of the maker communities worldwide.

To follow this chapter and the rest of this book, you'll need to buy an Arduino board, and download the
software. Go to its web site at www.arduino.cc, get the Arduino IDE (Integrated Development Environment,
the Arduino software), and find your local distributor. At the time of writing (August 2015), there are issues
within the Arduino team. This means that if you buy an Arduino outside the United States, it will be called
Genuino. The name is the only thing that changes, the rest remain the same. This change applies for a few
boards, the UNO, the MICRO, and the MEGA. The NANO and the PRO MINI, shouldn’t be affected. These
issue should actually be solved with the appearance of the Genuino. Still, we’ll refer to it as Arduino, and
we’ll mean both boards, since they are essentially the same.

With Arduino, it is advisable to get the UNO, as it is designed for prototyping. In this chapter, this is the
Arduino we’ll use. In the chapters that follow, we’ll use other types of Arduino, like the NANO and the PRO
MINI, as they are much smaller, so not so good for prototyping, but perfect for being embedded in a project.
Their cost is rather low, maybe the NANO is a little bit more expensive, so it shouldn’t be very difficult to get
one of each. Don’t bother to buy them all yet, if you want to build a project in this book that requires another
type that you don’t have, then go get one.

Along with the Arduino, we’ll be using some peripherals, like LEDs, switches, potentiometers, and
so forth. Each project will needs its own peripherals, so you should probably get them as you go. In this
chapter, we'll use peripherals for prototyping, so instead of potentiometers, we'll use trimmers (these are
breadboard-friendly potentiometers). These prototyping peripherals will be helpful for many more projects,
as when building an electronics project, we first prototype and them start building.

At this point, I should mention that there is a rather easy way to use the Arduino, if you're already using
Pd. That is the Firmata library, which lets you program the Arduino through Pd (or other programming
environments). Since we'll be using some built-in functions of the Arduino language, using Firmata here
won't really help, so we’re not going to use it at all. Instead, we're going to write our own small programs and
restrict the Arduino to the few simple things we need to use. This way we’'ll get a better understanding of its
language, the serial communication, and how it is combined with Pd.

Parts List

In this section, we’ll review the parts you'll need to build all the projects of this chapter. Table 2-1 shows
what each project will use. In addition to that, you'll need some jumper wire (make sure that you get a few),
a breadboard (a half size will probably do, but a full size won’t be bad, as it will prove useful for future
projects too), and of course, an Arduino Uno and a USB cable.

Table 2-1. Parts List

Project  LEDs Push buttons Potentiometers Resistors

1 1 0 0 0
2 0 1 0 1 x 10KQ
3 1 1 0 1 x220Q2
4 0 0 1x 10KQ 0
5 1 0 1x 10KQ 1 x 220Q2
6 0 0 3x10KQ 0
7 0 3 3x 10KQ 0
8 3 0 0 3 x220Q
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Make sure that the push buttons you get are breadboard-friendly (also called tactile switches), as well
as the potentiometers (these one are also called frimmers). The resistors are counted in ohms, so a 10KQ
resistor is 10 kiloohms, and a 220Q is a 220-ohm resistor.

The Blink Sketch

Before we start looking at Arduino code, make sure you have yourself an Arduino, preferably the UNO, so
you can realize all the programs in this chapter. Figure 2-1 shows an Arduino UNO. The chip in the middle of
the board is the actual microcontroller, an Atmel ATMEGA 328. We can also see a USB socket that we’ll use to
connect it to our computer. There’s also a power JACK socket on the same side with the USB, but since we’ll
use the Arduino always in combination with a computer, we won’t need that, as it will be powered through
the USB. On the sides, we can see a few sockets with some indications on them. These are the pins to which
we'll be attaching sensors, LEDs, and so forth. There are both analog and digital pins, for the corresponding
sensors. On each project, there will be a diagram of the circuit, so it will be easy to follow.

Figure 2-1. Arduino UNO

When learning programming, usually the first task is to print “Hello, World!” to a monitor. In Pd, the first
thing we did was to output a sine tone at 440 Hz (that is the usual case when learning audio programming).
When learning how to program the Arduino, we usually make an LED blink. In electronics, making LEDs
blink is the very basis. It is said that, if you can make an LED light up, you can do anything. So what we’ll do
first in this chapter is to make an LED blink. The Arduino IDE has a sketch (this is how we refer to Arduino
code) that does exactly that.

Go ahead and launch the Arduino IDE. What you'll get at the beginning is a new sketch window, like
the one in Figure 2-2. In contrast to Pd, this window is not totally empty. First of all, at the very top, it writes
“sketch_aug07a | Arduino 1.6.5" This is a default sketch name given by the IDE. “aug” stands for August
(all this is written in August), “08” stands for the eighth of the month, and “a” stands for the first sketch of
the day. If you reach the limit of the Latin alphabet, you'll get a window saying, “You've reached the limit for
auto naming of new sketches of the day. How about going for a walk instead?” and it won't let you create a
new sketch. Just restart the application and it will work again. I'm pretty sure that you won’t reach that limit
unintentionally (I kept on creating new windows till I got to the end, just to see what happens). The second
part of the top line is the version of the IDE you're using.
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ann sketch_aug08a | Arduino 1.6.5

01

'/ put your setup code here, to run once:

Arduino Uno on fdevicu usbmodemdll

Figure 2-2. A new sketch window

On the very bottom of the window, on the left side you can see the line in your sketch where the cursor
currently is. On the right side, you see the selected Arduino board and its serial port (can’t really remember
if there was any serial port when I first installed the IDE and opened a new window without having set a port
yet). In the case in Figure 2-1, it's an Arduino Uno, on port /dev/cu.usbmodem411 (this is on OS X). Later on,
we'll talk about all this in more detail.

In the window, we see a little bit of code. The first line reads void setup() {.This is a built-in function
that runs once as soon as the Arduino is powered. We won’t bother with the word void for now. setup
is the name of the function. When we program in C++, we can create our own functions, and we have to
give them a name. Think of it a bit like an abstraction in Pd. The parenthesis are obligatory when writing a
function. They are there in case the function takes arguments, and even if it takes no arguments, you must
still include them. After the parenthesis, there is an opening curly bracket. When we define a function, its
code is included in curly brackets, and we can see the closing bracket in line 4. Whatever is written inside
these brackets is the code of the function, which will be executed when we call that function (for the setup
function, as soon as the Arduino is powered). By “define,” I mean to write the code of the function. Both
setup and loop are not defined by default, but are there for us to define them any way we want.

Line 2 has a comment. This is like the comments in Pd, they are there to give us information, and they
don’t affect the program at all. The compiler (the compiler is the program that turns code into an executable
program) will ignore all comments when it will compile the code. This is a single line comment and it must
start with two forward slashes. The comment reads "put your setup code here, to run once:".This
actually tells us what really happens with this function, it runs only once, when the Arduino boots.
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In line 7, we read void loop() {.This is another built-in function of the Arduino language and
runs immediately after the setup function, over and over again, hence its name loop. Again we have the
parenthesis, since it’s a function, and the curly brackets, because it hasn’t been defined yet. Inside it, we read
the comment, "put your main code here, to run repeatedly:".This is where we'll be writing most of
our code, and this will run for as long as the Arduino is powered.

The different colors for various keywords of functions and others, are there to facilitate the reading and
writing of code. Most of IDEs have color highlighting for this reason. In the Arduino language, the blueish
color of void is the color for data types (like integer, float, byte, etc.; you'll see them later on). The color of
setup and loop is the color for these two functions and all control structures (if, for, while, and others).

All comments are grey and all defined functions (not setup and loop) are orange. We'll see all this as we read
further on.

Now go to File » Examples » 01.Basics, and click Blink. This should open a new window with the
code in Listing 2-1 in it.

Listing 2-1. The Blink Sketch: the Equivalent to the “Hello World!” Program in Most Programming
Languages

1. /*

2. Blink

3. Turns on an LED on for one second, then off for one second, repeatedly.
4.

5. Most Arduinos have an on-board LED you can control. On the Uno and

6. Leonardo, it is attached to digital pin 13. If you're unsure what

7. pin the on-board LED is connected to on your Arduino model, check

8. the documentation at http://www.arduino.cc

9.

10. This example code is in the public domain.

11.

12. modified 8 May 2014

13. by Scott Fitzgerald

14. */

15.

16.

17.  // the setup function runs once when you press reset or power the board
18.  void setup() {

19. // initialize digital pin 13 as an output.

20. pinMode(13, OUTPUT);

21, }

22.

23.  // the loop function runs over and over again forever

24.  void loop() {

25. digitalWrite(13, HIGH); // turn the LED on (HICH is the voltage level)
26. delay(1000); // wait for a second

27. digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
28. delay(1000); // wait for a second

29. }

This is the first Arduino sketch we’ll upload to our board. To get a grasp of how things work with
the Arduino, we'll go through its code in detail, step by step. The code here has all lines numbered for
convenience, but the Arduino IDE doesn’t show these line numbers, only the number of the line where the
cursor is, at the bottom of the window. The first fourteen lines of code are a multiline comment. To make a
multiline comment in Arduino, start it with a forward slash and an asterisk, and end it with an asterisk and
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a forward slash. Whatever you write in between will be ignored by the compiler. This specific comment tells
us what this sketch does, gives some information about the integrated LED on the Arduino and some other
meta-data.

After the multiline comment, we have a single line comment giving information about when the setup
function runs, and then we have the actual setup function. In line 19, we have a comment: "initialize
digital pin 13 as an output”.Indeed, line 20 does exactly that. Since we’ll use an LED and we will be
turning it on and off, the pin we’ll use for this is a digital pin, because it has two possible states only, on or
off (same as 1 or 0). Also, this pin will output voltage to the LED, so it must be an output pin. Digital pins
can be either input or output, whereas analog pins are only input. This line also shows how intuitive the
Arduino language is. The function to set a pin either as input or output—in other words, to set the mode
of the pin—is called pinMode, and you can tell that it’s a function by the parenthesis after its name. This
function is part of the core of the Arduino language and has already been defined. That’s why it has no curly
brackets, like setup and loop, and you can’t write code in it, but only use it as is. This is the first predefined
function we encounter and we can see that it is color highlighted in orange, as mentioned earlier. pinMode
takes two arguments, the pin to set the mode to, and the mode to set to that pin. The pin we’ll use is pin 13,
because that’s the pin Arduino Uno has an integrated LED on. For the second argument, we use a keyword
of the Arduino language, OUTPUT. This keyword (the language is case sensitive, so output won’t work) tells
pinMode to set the specified pin as an output. Mind the semicolon (;) at the end of the line. pinMode is a
predefined function, so we must put a semicolon whenever we call it. All executable lines of code in C++ end
with a semicolon. This tells the compiler that this is the end of the line and that this line must be executed.
Functions that are being defined (like the setup and 1loop) don'’t take a semicolon, but all code written inside
them does.

Our setup function consists of one line of code only (plus a single line comment). Line 21 closes the
brackets of the setup function and we move on to the loop function. Notice how all code within setup is
indented. The same happens with loop too. All functions and control structures have their code indented,
for readability. You'll see that it is a very helpful feature. In the Arduino IDE, when you open a curly bracket
and hit enter, the code automatically gets indented.

In our loop function, we can see four lines of code, where we call two functions, two times each. Both
these functions are predefined, like pinMode. The first one, on line 25 is the digitalWrite function. As its
name states, this function writes a value to a digital pin. Like pinMode, this one also takes two arguments,
the pin to write a value to, and the value to write to that pin. In this case, we want to turn the LED on pin 13
on. Again, we provide the number 13 for the pin number. On can be indicated by the keyword HIGH. HIGH
stands for high voltage. Sending voltage to that pin, will turn the LED on. Mind the semicolon after the
function call.

We can see that after the semicolon there is a single line comment. The comments we've seen so far start
at the beginning of the line, but single line comments can start at any point of a line. The compiler will compile
the line up to the point of the two forward slashes, after which point it will ignore everything. This comment
tells us what this line of code does, which is to "turn the LED on (HIGH is the voltage level)".

The next line reads delay(1000);. delay is another built-in, predefined function. What it does is
delay the rest of the program by a specified amount of time, which we set via its argument (delay takes one
argument only), in milliseconds. This line of code will delay the rest of the program for 1000 milliseconds, or
for 1 second. After we call that function, we put a semicolon to let the compiler know we’re done with that
line, and then there is a comment saying that we’llwait for a second.

After delay, we call digitallWrite again, but this time we set the pin LOW, meaning we drop the voltage low,
so the LED will turn off. The comment after the semicolon explains that as well. Lastly, we delay our program for
another second by calling delay(1000); as we did before. And this concludes our first Arduino sketch. In line 29,
we put the closing bracket for the loop function (no semicolon here as we are defining the function).

What you might have noticed is that in textual programming the code is being executed line by line,
the same way we read it. In visual programming, we can see the data flow by the connections between the
objects, in textual programming the data flow is being defined by the position of each line of code. Since I
have explained the Blink sketch, let’s upload the code to our Arduino board, to see it in action. Plug in your
Arduino and go to Tools » Board: and you’ll get the menu shown in Figure 2-3.
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Boards Manager...
Arduino Yun

v Arduino Uno
Arduino Duemilanove or Diecimila
Arduino Nano
Arduino Mega or Mega 2560
Arduino Mega ADK
Arduino Leonardo
Arduino Micro
Arduino Esplora
Arduino Mini
Arduino Ethernet
Arduino Fio
Arduino BT
LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor
Arduino Cemma

Figure 2-3. The Boards menu on the Arduino IDE

You can see that there are many different boards supported by the IDE. If the Uno is not already
selected, go ahead and click it (if you're using another board, click that). The menu will close, but the board
will have been selected. Once you've done that, you must select your port. Go to Tools » Port and a menu
with all available ports will open. The Arduino port should have an indication like the one in Figure 2-4. On
OS X the port is /dev/cu.usbmodemx,’ on Linux it’s /dev/ttyACMx, and on Windows it's COMx, where x is a
number. Select your port (again, the menu will close, but the port will have been selected) and you're ready
to upload the sketch to your board. On the top of the sketch window, there are a few icons, as shown in
Figure 2-5. The icon with the arrow inside it is the Upload button. Click it and the IDE should start uploading
the sketch to the board. Before it uploads the code to the board, it will first compile it, and on the bottom
of the sketch window, you'll see the compilation process progress, shown in Figure 2-6. When the code has
been compiled, the IDE will start uploading it to the board, and now you'll see the upload progress, shown in
Figure 2-7.

'On OS X there’s a /dev/tty.usbmodemx and a /dev/cu.usbmodemx. It used to be the tty. but the latest IDE hides
it. Selecting the cu. one is exactly the same.
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v /dev/cu.usbmodem411 (Arduino Uno)

Figure 2-4. Indication of the Arduino Uno port

Figure 2-5. Verify, Upload, and other choices on the Arduino sketch window

Figure 2-6. Compilation process progress on the IDE window

Figure 2-7. Upload progress on the IDE window

When the uploading has finished, on the bottom of the window you’ll read: “Done uploading.” On your
Arduino board, you should see an LED blinking, turning on for one second, and off for another second,
repeatedly. Congratulations! You've uploaded your first Arduino sketch!

Before we move on and start writing our own code, let’s use an external LED with this sketch. Usually
when we use LEDs, we also need to use resistors, because the voltage supplied by the Arduino is too
much for an LED, and most likely it will be burned, if there’s no resistor. Pin 13 on the Arduino Uno has
an integrated resistor, so to make this sketch work with an external LED, there’s no real circuit you need to
build yourself. An LED has two legs, one long and one short. The long one takes voltage, while the short one
connects to ground. By ground in electronic circuits, like the ones we’'ll build with the Arduino, we usually
mean zero volts. Even though there’s no connection with the real ground (the earth), we still call this ground.
Figure 2-8 shows how you should connect the LED to your Arduino.
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fritzing
Figure 2-8. LED connected to digital pin 13 and Ground

It is very convenient that there is a ground pin next to digital pin 13, so we can insert the LED straight
into the pin sockets (these are called headers, and that’s how we’ll refer to them from now on). Once you
plug your LED into the Arduino, you should see it blinking along with the integrated LED that is already
blinking. Now let’s write our own code to the Arduino!

Digital Input

From this point on we'll start needing some components to build the circuit of each project. The parts for
this project are shown in Table 2-2.

Table 2-2. Project 2 Parts List

Part Quantity
Push buttons 1
Resistors 1 x 10KQ

Since you saw how we give digital output, now we’'ll receive some digital input. To do this we’ll need
a switch that we can read from the Arduino (actually, we'll use a momentary switch, essentially a push
button). We'll connect the switch to a digital pin, which we’ll configure as an input pin, and we’ll read
whatever the switch gives in the Arduino serial monitor. Open a new sketch window using the same shortcut
you opened a new window in Pd with: Ctrl/Cmd+N. Listing 2-2 shows the code you should write in the new
window.
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Listing 2-2. Receiving Digital Input in the Arduino

1. // set a global variable for the pin of the switch
2. int switch_pin = 2;

3.

4. void setup() {

5. // initialize the switch pin as input

6. pinMode(switch_pin, INPUT);

7.

8. // start the serial communication so we can see the readings in our computer
9. Serial.begin(9600);

10. }

11.

12.  void loop() {

13. // store the state of the switch to a variable
14. int switch_state = digitalRead(switch_pin);

15.

16. // print the variable to the Serial Monitor

17. Serial.println(switch_state);

18.

19. // short delay so that we don't receive massive data
20. delay(250);

21, }

Defining Variables in Arduino

Line 1 says thatwe’ll "set a global variable for the pin of the switch", and we do exactly that on line 2.
This line sets a variable of type int, called switch pin, and assigns the value 2 to it. An int in the Arduino
language is an integer (a value with no decimal point), that is two bytes long (it can hold values from -32,768
up to 32,767). In Pd, we didn’t deal with different data types because all numbers are actually floats. In
Arduino (and C/C++ programming), we must always define the type of the data whenever we create a new
variable. Sometimes we might need an integer, other time we might need a float, also we might need two
bytes, or four, or one. Therefore, we must always define the data type. The syntax of line 2 is the one we use
when we create a new variable, which is: data type, identifier, value assignment. The last part (where we
assign a value to the variable) is not mandatory, but the first two are. In this specific sketch, using a variable
is not really necessary, as with the Blink sketch, but it’s good practice to use it, so we can get the hang of

it. Also, this variable is called global because it is defined outside any function, at the top of the sketch,
therefore is accessible by any function (note that this variable is called by both setup and loop). If it were
defined inside one of the two functions, then the other function wouldn’t have access to it, and it would be
called a local variable. We'll see more of these as we write more code.

Further Explanation of the Code

Now that I've explained the first two lines of code, which are not specific to this sketch only, let’s move
further. Note that we use digital pin 2, and not 0 (pins start counting from 0), because digital pins 0 and 1 are
used for receiving and transferring data, so we start using pins from 2 onward.

In line 4, we define our setup function. Like with the Blink sketch, we call the pinMode function to set
the mode of the pin we’ll use. This time, since we'll be receiving input from the Arduino, we set the pin
as INPUT. With the sketch we’ll also need to have serial communication, so the setup function goes on to
set that as well. Line 8 contains the comment "start the serial communication so we can see the
readings in our computer" and line 9 calls the begin function of the Serial class.
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Classes in Arduino and the Serial Communication

We can tell that Serial is a class, because there is a dot between it and its function that we call, begin. The
class name is also in bold letters (not on OS X), which declares that this is a class. A class in C++ is a set

of functions and data that comprise a user-defined data type. They are there to make things easier when
coding, as they are actually a package of methods that we often use. It is different than an abstraction,
because the abstraction is a single function, we write once and use lots of times, whereas a class packs
many functions together, along with its own data. It’s not really necessary to grasp what a class is in C++, the
details provided are there just to give some information. To come back to our code, line 9 begins the serial
communication between the Arduino and the computer at the rate of 9600 bits per second, which is set via
the argument of begin. The communication is called serial, because the bits come in the communication
line is series, one at a time.

Further Explanation

Line 10 has the closing curly bracket of the setup function, which is there by default, when you open a new
window in the Arduino IDE. Curly brackets are necessary for function definitions and control structures,
which we will see later on. Forgetting to include one will create an error message at the bottom of the sketch
window and the code will fail to compile. Luckily, when you put an opening curly bracket in the Arduino
IDE, and hit return, it automatically inserts the corresponding closing bracket, so it’s almost impossible to
forget it and cause an error.

In line 12, we start our loop function. Line 14 creates a new variable of type int, called switch_state,
and assigns to it the value returned by the digitalRead function. digitalRead is the counterpart of the
digitalWrite function, and as its name states, it reads the value of a digital pin. This function takes one
argument only, which is the pin to read from. Compare line 14 to line 2. They are very similar, only in the
case of line 2, we assign a fixed value to our variable, whereas in the case of line 14 we assign a different
value every time, the one read and returned by the digitalRead function. The argument we provide to
digitalRead is the variable that holds the number of the pin we’ll attach the switch to, defined in line 2.
Using variables with names that make sense, make our code self-explanatory and easier to read. Line 14
should be fairly easy to understand without explanations.

Line 17 calls the println function of the Serial class. Like with the begin function, we must include the
class name and place a dot between it and the name of the function, like this:

Serial.println(switch state);

This function prints whatever is provided inside its parenthesis, to the serial port. In this case, it prints
the value stored in the switch_state variable. For this sketch, we’ll use the serial monitor of the Arduino IDE
to see what the Arduino prints. Later on, we'll start receiving data in Pd, which is our goal.

Finally, in line 20 we delay our program by 250 milliseconds, so that we don’t get massive amounts of
data in the serial monitor. This delay is only for this reason, when we’ll use Arduino with Pd, we won’t be
using these delays.

Building Circuits on a Breadboard

Before we check the circuit for this sketch, I'll explain what a breadboard is and how it works. A breadboard
is a board that facilitates testing circuits a lot. It has small holes where jumper wires fit, and these holes are
connected in a certain way to help connect the wires to other parts, like resistors, push buttons, LEDs, and
so forth. Figure 2-9 shows the wiring of a small breadboard. On the top and the bottom, there is a blue and a
red line. The black wire that goes along the blue line shows that all holes along the wire are connected with
each other. So if you plug in a wire at one end of this line, and another wire at the other end, these wires will

61



CHAPTER 2 * INTRODUCTION TO ARDUINO

be connected. The same goes for the red wire along the red line, and this applies to both top and bottom.
The green and yellow wires show how the holes are connected in the inside part of the breadboard. Up until
the notch in the middle of the board, the lines are connected vertically, as we see the board in Figure 2-9.
Building the circuit of this sketch will help you understand how the breadboard works.
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fritzing
Figure 2-9. Breadboard wiring

The circuit is shown in Figure 2-10.
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Figure 2-10. Digital input circuit

The push button of the circuit has two pairs of two connected legs. The legs on the left side are
connected between them, and the legs on the right side too. The two sides are not connected until we press
the button. One of the two leg pairs connects to 5V (this means five volts), and the other leg pair connects
to one leg of the 10kQ resistor (it doesn’t matter which one), and the other leg of the resistor connects
to ground (anywhere along the bottom blue line). The resistor applies some resistance to an electrical
current. The amount of resistance it applies is expressed in ohms. If we don’t use a resistor in our circuit,
as soon as we press the switch, we'll actually connect 5V to ground, creating a short circuit. The same leg
pair of the button that connects to the resistor also connects to the digital pin 2 of the Arduino (it’s the pin
we've set as input and the one we're reading in the Arduino code). We could have connected the resistor
straight to the ground pin of the Arduino (GND pin), and the right leg pair of the button straight to the 5V
pin, but providing voltage and ground to the board is good practice for later projects where we’ll have more
components requiring voltage and ground. Also, traditionally, we use black wire for ground and red for 5V.
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Go ahead and upload the sketch to your board. The IDE will prompt you to save it. When you install
the Arduino IDE, it automatically creates a folder called Arduino to the Documents folder (on Linux the
directory is called Sketchbook and should be in your home directory). If this folder doesn’t exist, go ahead
and create it. Save the sketch with the name Digital input. Checkifit’s saved. You'll see a folder with the
name Digital input in your Arduino folder, and in there the file Digital input.ino. The .ino extension is
for files read by the Arduino IDE. Once you upload the code to your board, open the serial monitor. To open
it, click the rightmost icon on top of the window, shown in Figure 2-5. Figure 2-11 shows the readings of the
switch being printed onto the serial monitor. Make sure that the menu on the bottom left of the window
reads “9600 baud”. This is the baud rate we’ve set to the Serial communication with Serial.begin(9600);
(baud rate is the rate of bits per second, that’s how we'll refer to it from now on). Also, make sure that the
menu next to it reads “Newline” (I'll explain what this is further on). These two are necessary for the Arduino
to print to the monitor properly, since we've set them in the code. Now you should see a number every 250
milliseconds, which should be a 0 when you don’t press the switch, and a 1 when you press it.

eno /dev/cu.usbmodem411 (Arduino Uno)
| Send

CEEEEEEEEEEEE R I T T

™ Autoscroll Newline & 9600 baud A

Figure 2-11. Arduino’s serial monitor

Pull-up vs. Pull-down Resistors

There’s one last thing I need to explain before we move on to the next sketch. The resistor used in this

circuit is called a pull-down resistor, because it connects the switch to ground. If instead we reverse the
connections, so the resistor connects to 5V (any hole along the red line), and the right leg pair of the push
button connects to ground (any hole along the blue line), the resistor will be a pull-up resistor. This will
create a reversal in the readings of the switch, meaning that the Arduino will print a 1 when you don’t press
the switch, and a 0 when you press. This is a bit counter intuitive, but it is said that pull-up resistors are more
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stable in a circuit, than pull-down. Apart from that, all pins in the Arduino have internal pull-up resistors,
which are disabled. To enable a pull-up resistor in a pin, we must call the pinMode function. Open a new
sketch window and copy the previous code to it (if you change the code in the previous sketch and upload it,
the IDE will automatically save it). In the new sketch change line 6 to this:

pinMode(switch_pin, INPUT_PULLUP);

Also, change your circuit to the one in Figure 2-12. Using Arduino’s internal pull-up resistors reduced
the circuit we need to build a bit. This will come in handy when we’ll start building circuits on a perforated
board, as it will reduce the amount of soldering to a great extent. These resistors are 20k<, but they're still
good for us to use with switches. Don’t confuse them with the internal resistor on pin 13, which we used
with the Blink sketch. That resistor connects pin 13 of the processor to the header where we attached the
LED, whereas the pull-up resistors connect the pins of the processor to 5V. We first built the circuit with an
external resistor, to clarify how the actual circuit works, because if we used the internal one straight away,
you probably wouldn’t understand the circuit the same way.
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Figure 2-12. Digital input with internal pull-up resistor enabled
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Both Digital Input and Output

A logical next step would be to combine the two sketches we’ve already analyzed. What we’ll do is use the
switch both for visualizing it in the Arduino serial monitor, but also to control an LED. Table 2-3 shows
the parts needed to realize this project.

Table 2-3. Project 3 Parts List

Part Quantity
Push buttons 1
LEDs 1
Resistors 1 x 220Q2

This time we’ll use another pin for the LED, that doesn’t have an internal resistor like pin 13 (unlike the
pull-up resistors, only pin 13 has an internal resistor that can be used with an LED). Here we'll also see why it
is good practice to store readings in variables, as we’ll use the reading of the digital pin 2, both for projecting
in to the serial monitor, but also for controlling the LED. Listing 2-3 shows the code you should write.

Listing 2-3. Digital Input and Output Sketch

1. // set a global variable for the pin of the switch

2. int switch_pin = 2;

3. // set a global variable for the pin of the LED

4. int led_pin = 8;

5.

6. void setup() {

7. // initialize the switch pin as input with the internal pull-up resistor
8. pinMode(switch_pin, INPUT PULLUP);

9. // initialize the LED pin as output

10. pinMode(led pin, OUTPUT);

11.

12. // start the serial communication so we can see the readings in our computer
13. Serial.begin(9600);

14. }

15.

16.  void loop() {

17. // store the state of the switch to a variable

18. int switch_state = digitalRead(switch_pin);

19.

20. // write the reading of the switch to the LED

21. digitalWrite(led pin, switch_state);

22.

23. // print the variable to the Serial Monitor

24. Serial.println(switch_state);

25.

26. // short delay so that we don't receive massive data
27. delay(250);

28.  }
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This code is very similar to the code in Listing 2-2. What’s new is line 4, where we set a global variable
for the pin of the LED, which is 8. In the setup function, we call the pinMode function for both pins, but we
set the switch_pinas INPUT_PULLUP, and the led_pin as OUTPUT. Then in line 21, we use the value stored in
the switch_state variable, to control the LED, by calling the digitalWrite function like this:

digitalWrite(led pin, switch_state);

In line 24, we print the value of switch_state to the serial monitor. Instead of creating a variable for the
switch readings, we could have called the digitalRead function twice. So line 21 could read:

digitalWrite(led pin, digitalRead(switch pin));
And line 24 could read:
Serial.println(digitalRead(switch_pin));

And line 18 could have been avoided altogether. We could have even avoided to create the switch_pin
variable, and write the number 2 in its place instead. This whole approach is problematic for the following
reasons. The Arduino takes some time to read a pin (especially the analog pins), and calling a function
that reads a pin more than once is not very efficient. Calling that function once and storing its reading to a
variable, and then calling that variable instead, is much faster, efficient, and easier to read and understand.
Also, avoiding a variable for the pin number of the switch can cause some problems, if for some reason we
decide to change that pin. If you use a variable, you'll have to change one line of code only, the variable
declaration. If you're not using a variable, you'll have to change that pin number in any line of code where
you use it. Figure 2-13 shows the circuit for this sketch.
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Figure 2-13. Digital input and output circuit

We could have use digital pin 13 for the LED, which has an internal resistor, but we prefer to use an
external resistor, so you can see how a circuit using LEDs actually works. Build the circuit and upload your
code. Don't save it yet when the IDE prompts you, just click Cancel and the code will be uploaded without
being saved. Open the serial monitor too. Now whenever you press the switch the LED should go off, and
whenever you release it, it should go on. But wait a minute, this should be the other way round, right? This
inversion happens because of the pull-up resistor we have enabled in the switch pin. The LED should be
aligned with the readings you see in the serial monitor. Whenever you press the switch, you should see 0s in
the monitor, and the LED going off, and whenever you release it, you should see 1s and the LED going on.
We can very easily reverse this whole process by adding a single character to our code. Go back to your code
and change line 18 to this:

int switch state = !digitalRead(switch pin);
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All we did was add an exclamation mark just before digitalRead. The exclamation mark in C/C++ when
used before a value (digitalRead returns a value, so we should treat calling it like writing a value) means
“the reverse of” Adding the exclamation mark to this line, should reverse the readings of the digital pin 2, so
now whenever you press the switch you should see the LED going on, and 1s in the serial monitor, and the
other way round. There should be a tiny bit of lag to the reaction of the LED, which is because of line 27:

delay(250);

This is used to avoid receiving massive amounts of data. We won'’t be using that when we build musical
interfaces.

Analog Input

The next thing that we’ll look at is getting input from the analog pins of the Arduino. Table 2-4 shows the
parts for this sketch.

Table 2-4. Project 4 Parts List

Part Quantity

Potentiometers 1 x 10KQ

There are many sensors you can use with the analog pins, like proximity sensors, vibration sensors,
accelerometers, and many more. For now, we'll just use a potentiometer, to see how to use the analog pins of
the Arduino. Listing 2-4 shows the code.

Listing 2-4. Analog Input Sketch

1 int analog_pin = 0;

2

3 void setup() {

4. // begin the serial communication

5. Serial.begin(9600);

6

7

8 void loop() {

9. // store value of potentiometer to a variable
10. int pot val = analogRead(analog pin);
11.

12. // print it to the Serial Monitor

13. Serial.println(pot_val);

14.

15. // short delay to avoid massive data
16. delay(250);

17.  }

This code is also very similar to the code in Listing 2-2. In line 1, we define a variable for the analog pin
number. If you look at your board, you'll see that the analog pins start from A0, up to A5. We can omit the
letter A, which stands for analog, but if you like, you can include it and write this line like this:

int analog_pin = Ao;

69



CHAPTER 2 " INTRODUCTION TO ARDUINO

In the setup function, we're not calling pinMode anymore, because as already stated, the analog pins are
input only, so we don’t need to set their mode. We're just starting the serial communication with a
9600 baud rate. In the loop function, we create a variable to hold the value read by the potentiometer, but this
time we call the analogRead function. This function is very similar to its digital counterpart, digitalRead. It
takes one argument, which is the analog pin to read from, and returns the value read from that pin. In line 13,
we print that value to the serial monitor, the same way we did before. Finally, we use the delay function, in
order not to get a massive amount of data. Figure 2-14 shows the circuit for this code.
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Figure 2-14. Analog input circuit

The potentiometer is actually a variable resistor. That’s why the ohms are mentioned in the components
of this circuit. It has three legs, where one of the side ones connects to ground, the other side leg connects
to 5V, and the middle leg (called the wiper) connects to the analog pin of the Arduino. As you spin the
potentiometer, the resistance it applies to the circuit varies. It doesn’t really matter which of the side legs
will go to ground and which to 5V, only the increasing/decreasing of the resistance will change direction.
If you connect the left leg to ground and the right to 5V, then the resistance will drop as you spin the
potentiometer clockwise, and the values you'll receive will increment. If you connect the legs the other way
round, this process will be reversed. Most of the time, we want to have incrementing values as we spin the
potentiometer clockwise, so you might want to connect its legs as shown in Figure 2-14.
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Upload the sketch to your board and when prompted, save it as Analog_input. Open the serial monitor
of the IDE and you should see something like the Figure 2-15. As you spin the potentiometer clockwise you
should see the values increase (or decrease, depending on the way you built the circuit) and vice versa.

The minimum value you get is 0 and the maximum is 1023. This is because the Arduino Uno has 10-bit
resolution analog pins. This means that it can express the voltage it receives with 10 bits. In the decimal
numeral system, this is expressed as 2 to the 10nth power, which is 1024. Since the number 0 is in that
range, what we get is a range from 0 to 1023, which is in total 1024 values. In general, in a number stream
that represents a signal, when starting from 0, the maximum value is always (2/bit-depth) - 1 (the A symbol
raises 2 to the power of the bit-depth).

eno Jdev/cu.usbmodem411 (Arduino Uno)
Send
697
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697
696
696
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816
877
920
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1823
1823
1823
961
914
859
847
848
885
799
789
™ Autoscroll Newline s 9600 baud :

Figure 2-15. Receiving analog values in the serial monitor

Analog Input and Output

As with the digital pins, we'll now look at both input and output with the analog pins. Table 2-5 shows the
components needed for this sketch.

Table 2-5. Project 5 Parts List

Part Quantity
Potentiometers 1 x 10KQ
LEDs 1

Res 1 x220Q
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The name of this section might sound a bit strange, as I've already mentioned that the analog pins of
the Arduino are input only. By “analog output” I don’t really mean analog, but digital. Six of the digital pins
of the Arduino have PWM capabilities. PWM stands for pulse-width modulation. This is similar to the duty
cycle of the square wave oscillator we made in Pd. PWM essentially controls the amount of time a digital pin
will be HIGH and LOW, during one period of a specified frequency. Quoting from the Arduino web site,
“The frequency of the PWM signal on most pins is approximately 490 Hz. On the Uno and similar boards,
pins 5 and 6 have a frequency of approximately 980 Hz.” To make this a bit clearer, most PWM pins run at
a 490 Hz frequency. When we control the width of the pulse, we control the percentage of the HIGH and
LOW states of one period of this frequency, which lasts 1/490 seconds (hertz is a time unit of repetitions per
second). During this small amount of time, we control how much of this time the pin will be HIGH, and how
much it will be LOW.

PWM can fake a dimming effect when we use LEDs with it. For example, if the PWM pin is 100% HIGH
and 0% LOW, then we see the LED being fully lit. If the pin is 50% HIGH and 50% LOW, then we see the LED
halflit, and it the pin is 25% HIGH and 75% LOW, we see the LED dimly lit. For this sketch, we’re going to use
a potentiometer to control a PWM, where we'll attach an LED. Listing 2-5 shows the code.

Listing 2-5. Analog Input and Output Sketch

1 int pot_pin = 0;

2 int led pin = 9;

3

4. void setup() {

5. pinMode(led pin, OUTPUT);

6 }

7

8 void loop() {

9. int pot val = analogRead(pot pin);

10.

11. // map the readings of the potentiometer to the range of PWM
12. pot_val = map(pot val, 0, 1023, 0, 255);
13.

14. // write the mapped value to the PWM pin of the LED
15. analoghrite(led_pin, pot_val);
6. }

You may have noticed that the more code we write, the less comments we use. Comments are always
helpful, but as we start to learn the language, we use self-explanatory code that makes comments in certain
cases unnecessary. For example, we don’t use any comments in the first two lines, and by now you should
understand what these two lines of code do. Notice that in the setup function, we don’t start the serial
communication, as we don’t care to see the values of the potentiometer, since the LED will provide the
necessary visual feedback (the brighter the LED, the greater the potentiometer value). We only call the
pinMode function to set the mode of the LED pin.

In our loop function, we first store the potentiometer value to a variable, and then we call a new
function, map. This function maps a specified range of values to another range. It takes five arguments, which
are the variable that holds the range we want to map, the lowest value of the range we want to map, the
highest value of the range we want to map, the lowest value of the desired range, and the highest value of the
desired range. Notice that we're mapping the pot_val variable, but we’re saving the value returned by map to
the same variable, since we write:

pot_val = map(pot_val, 0, 1023, 0, 255);
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This is legal and works as expected. What we see in this line of code is that we want to store to the
pot_val variable, the value it holds, mapped from a range from 0 to 1023, to a range from 0 to 255. If the
potentiometer has a value of 511, then this line will store the value 127 to the pot_val variable. This mapping
is necessary because PWM in Arduino has an 8-bit resolution. Remember that a number stream starting
from 0, will go up to (2Abit-depth) -1. 2 to the 8™ power, yields 256, minus 1 yields 255.

The last line of the loop function calls the analogWrite function, which is very similar to its digital
counterpart, digitallWrite. It takes two arguments, the pin to write a value to, and the value to write to that
pin. Here we write to the led_pin the pot_val value. The mapped example of the previous paragraph
(511 mapped to 127), will give approximately 50% (127 is almost half of 255), so the LED will look halflit.

Figure 2-16 shows the circuit. As you spin the potentiometer, you should see the LED dimming in and
out, looking like a real analog output.
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Figure 2-16. Analog input and output circuit

73



CHAPTER 2 * INTRODUCTION TO ARDUINO

Reading More Than One Pin, Arrays, and the for Loop

We have covered quite a lot of the Arduino language and ways to use it both with analog and digital input
and output. Now let’s see how we can read more than one pin, in an efficient way. Table 2-6 shows the
necessary components for this sketch.

Table 2-6. Project 6 Parts List

Part Quantity

Potentiometers 3

This part may be a little bit tricky, so you might need to go through it more than once. Say that we want
to use three potentiometers and print them all to the serial monitor. You could write the following code:

int pot_pini = 0;
int pot_pin2 = 1;
int pot_pin3 = 2;

void setup() {
Serial.begin(9600);

void loop() {
int pot_vall = analogRead(pot pini1);
int pot_val2 = analogRead(pot pin2);
int pot_val3 = analogRead(pot_pin3);

Serial.println(pot_val1);
Serial.println(pot val2);
Serial.println(pot val3);

But this way of writing code is really not efficient, as the more pins we add, the more we have to
duplicate code, plus we can'’t really group the values we want to read. This is where the for loop comes
in handy.

Explaining the for Loop

The for loop has the following syntax:
for(int i = 0; i < some_value; i++)

After this declaration, we insert curly brackets, and inside the brackets we write the code we want to
have executed within the loop, much like we do when we define a function (the setup of 1loop function, only
the curly brackets for these functions are there by default). What this loop does is create the variable i and
assign it the value 0. Then it goes to the second field, which is a condition. If this condition is met (in this
example, if i is less than some_value), the code inside the loop’s curly brackets will be executed, and the loop
will go to the last field, i++, which is a shortcut for incrementing i by 1. After that, the condition is tested
again, and if it’s true, again the loop’s code will be executed. And this runs over and over, until i is not less
than some_value anymore.
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Using Arrays in Arduino

Before we apply the for loop to code that we’ll write, I need to explain the array in the Arduino language.
This is much like the array in Pd, only there’s no graph of the table. An array can be of any data type
(except void) and its declaration has the following syntax:

int pots[3];

This will create an array of three ints, called pots. We can access the elements of the array by means of
indexing, much like we did in Pd. So, to write a value to the first element of pots, we must do the following:

pots[0] = some_value;
Applying these two features to our code, we can now write the code in Listing 2-6.

Listing 2-6. Using the for Loop and Arrays

1. // create an array to store the values of the potentiometers
2. int pots[3];

3.

4. void setup() {

5. Serial.begin(9600);

6.

7.

8. void loop() {

9. for(int 1 = 0; i < 3; i++){
10. pots[i] = analogRead(i);
11. }

12.

13. Serial.print("Pot values: ");
14. Serial.print(pots[0]);

15. Serial.print(" ");

16. Serial.print(pots[1]);

17. Serial.print(" ");

18. Serial.println(pots[2]);
19.

20. delay(500);

21, }

What happens in line 9 is that the for loop will run for as long as i is less than 3, which will happen three
times (mind, not less than or equal to three, but only less than 3), as many as the potentiometers we’re using.
Note that we use the variable i both for indexing the pots array, but also as the argument to the analogRead
function. All this is legal, since i will take the values 0, 1, and 2 sequentially, which are the indexes of the
pots array, and the analog pins we want to read. We could have use a for loop for printing the values too,
but that would make things a bit more complicated, so we’ll leave it for later. One important thing here is
that i is a local variable to the for loop, and as soon as the loop is finished, i won’t exist anymore, until the
next the loop will run. The advantage of this is that a local variable is faster to access, and frees the memory it
allocates when it is destroyed (when the function defined inside it exits).

Line 13 calls the print function of the Serial class. Its difference to the println function of the same
class is that it will print whatever is inside its parenthesis, but anything printed afterward will be printed to
the same line. println causes the serial monitor to go one line below after it prints, like hitting the Return
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key on your keyboard (1n stands for newline). We print white spaces in between the values to get a clearer
print on the monitor. Running this sketch and opening the serial monitor, you should get something like

what'’s shown in Figure 2-17.

8006 /dev/cu.usbmodem411 (Arduino Uno)

| [ send |

Pot values: 474 580 487
Pot values: 556 580 613
Pot values: 622 510 614
Pot values: 622 178 614
Pot values: 325 264 615
Pot values: 379 627 615
Pot values: 556 €628 615
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Pot values: 551 629 615
Pot values: 552 629 615
Pot values: 553 628 615
Pot values: 552 €28 615
Pot values: 552 €28 615
Pot values: 553 628 481
Pot values: 726 628 481
Pot values: 499 993 481
Pot values: 211 664 481
Pot values: 574 664 401
Pot values: 581 €63 3@9
Pot values: 437 663 309
Pot values: 428 633 309
Pot values: 421 570 310
Pot values: 480 570 310
Pot values: 480 578 191
Pot values: 480 377 192
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Pot values: 628 377 334
Pot values: 645 471 334
Pot values: 378 484 334
Pot values: 461 484 203
Pot values: 455 483 163
Pot values: 489 483 164
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.
v |

Figure 2-17. Reading three potentiometers

Although it is probably rather obvious, Figure 2-18 shows the circuit for this sketch.
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Figure 2-18. Three potentiometer circuit

Analog and Digital Input

Now that we've seen the for loop in action, let’s write some code that utilizes both potentiometers and push
buttons. Table 2-7 shows the necessary components.

Table 2-7. Project 7 Parts List

Part Quantity
Potentiometers 3
Push buttons 3

This time we’ll make our code even more efficient, by applying the loop to the printing functions as
well. We'll keep the three potentiometers we used in the previous example, and we're going to add three
push buttons to our circuit and code.
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Listing 2-7 shows the code. There are a few new things in this code, so I'll explain them in detail. Line 2
defines the size of the array that will hold the analog pin values (the array name changed to analog_values
to be more generic, and not only potentiometer oriented). Array sizes need to be constant, so when defining
its size we must use the const keyword. const makes a variable read-only, which means that we cannot
modify it anywhere else in our program. If you omit to use the const keyword when defining the size of an
array via a variable, the Arduino IDE will throw an error and won’t compile the code.

Listing 2-7. Analog and Digital Input

1. // analog values array size, must be constant
2. const int num_of analog pins = 3;

3. // digital values array size, must be constant
4. const int num_of digital pins = 3;

5.

6. // create an array to store the values of the analog values
7. int analog values[num of analog pins];

8. // create an array to store the values of the digital values
9. int digital values[num of digital pins];

10.

11.  void setup() {

12. for(int i = 0; 1 < num_of_digital pins; i++){
13. pinMode((i + 2), INPUT_PULLUP);

14.

15. Serial.begin(9600);

16. }

17.

18.  void loop() {

19. for(int i = 0; i < num_of analog pins; i++){
20. analog values[i] = analogRead(i);

21. }

22.

23. for(int i = 0; 1 < num_of_digital pins; i++){
24. digital values[i] = !digitalRead(i + 2);
25. }

26.

27. Serial.print("Analog values: ");

28. for(int i = 0; i < num_of analog pins; i++){
29. Serial.print(analog values[i]);

30. Serial.print(" ");

31. }

32.

33. Serial.print("Digital values: ");

34. for(int i = 0; i < (num_of digital pins - 1); i++){
35. Serial.print(digital_values[i]);

36. Serial.print(" ");

37.

38. Serial.println(digital values[num of digital pins - 1]);
39.

40. delay(500);

41. }
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Line 4 defines the size of the array that will hold the values of the digital pins, the same way line 2 did for
the analog ones. We could have initialized both arrays by writing their size as a number inside their square
brackets, but we need these two values in more places in our code, so it’s more efficient to initialize the
arrays this way. Lines 7 and 9 initialize the two arrays using the preceding two constant values.

In the setup function we use the for loop to set the mode of the digital pins. This way we only need to
write the for loop header (the header of the loop is this (int 1 = 0; i < num_of digital pins; i++)),
and one line of code to set the mode of all pins we’re using. In this case, without using the loop, we would
write three lines of code, since we use three digital pins, and now we have written two lines, which is not so
much less. Imagine if we used all 12 available digital pins. Then we would have saved quite some coding.

In general we prefer to use the for loop in many cases of repetition. As stated earlier, we use the num_of _
digital pins constantin the condition test of the for loop. This should make it clear why we prefer to
initialize arrays with constants, rather than hard-code their size in their declaration square brackets.

Another thing to mention is that when we define a control structure, like the for loop, if the code of the
loop is only one line (like our case, where the code is only pinMode((i + 2), INPUT_PULLUP);), we can omit
the curly brackets; we can even write that line on the same line with the control structure’s header. So lines 12
to 14 can also be written like this:

for(int i = 0; i < num_of_digital pins; i++) pinMode((i + 2), INPUT_PULLUP);

This syntax is perfectly legal. Before we move on to the rest of the code, notice that we add 2 to the
i variable inside the pinMode function. This is because i has been initialized to 0 (so we can combine it with the
num_of digital pins constant, and the for loop can run three times), but we use digital pins from 2 onward.
We can see here that a variable of this type is a numeric value and we can apply math operations to it.

In line 19 we run a for loop to read and store the values from the analog pins. Again, we could have
omitted the curly brackets. In line 23, we run another for loop to read and store the values from the digital
pins we’re using. Again we’re adding 2 to the i variable, as we need to initialize it to 0, so the loop can run
properly, combined with the num_of_digital pins constant.

In line 27, we print an indication that the following values are from the analog pins. The text inside the
quotation marks is called a string. A string is essentially an array of characters, used to display text. After we
print the string, we use a for loop to print the values of the analog pins. This ti